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Important

 

Read this before using your copy of PowerQuest® Drive Image™

 

PowerQuest Corporation Software License Agreement

 

This document is a legal agreement between you, the “end user,” and PowerQuest Corporation. Use of the enclosed software indicates 
your acceptance of these terms. As used in this License Agreement, the term “SOFTWARE” means the Drive Image software included 
on the CD or disk media provided with this License Agreement. The term “SOFTWARE” does not include any software that is covered 
by a separate license offered or granted by a person other than PowerQuest.

IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, EITHER DESTROY OR RETURN, INTACT, THE 

DRIVE IMAGE PACKAGE, CONTAINING THE CD OR DISK MEDIA, TOGETHER WITH THE OTHER COMPONENTS OF 
THE PRODUCT TO THE PLACE OF PURCHASE.

1. PROPRIETARY RIGHTS. The SOFTWARE and any accompanying documentation are proprietary products of PowerQuest 
Corporation (“PowerQuest”) or its licensors and are protected under U.S. copyright laws and international treaty provisions. Ownership 
of the SOFTWARE and all copies, modifications, and merged portions thereof shall at all times remain with PowerQuest or its licensors.

2. GRANT OF LICENSE. The SOFTWARE and accompanying documentation are being licensed to you, which means you have the 
right to use the SOFTWARE only in accordance with this License Agreement. The SOFTWARE is considered in use on a computer 
when it is loaded into temporary memory or installed into permanent memory.

3. COMPUTER-SPECIFIC LICENSE. Each permitted copy of the SOFTWARE may be used only in connection with a hard drive(s) 
that is permanently connected to ONE specific computer (either a stand-alone computer or a computer connected to a network) owned or 
leased by you. Once a copy of the SOFTWARE has been used on a computer, it may not be used on any other computer, unless you have 
permanently stopped using (e.g., sold, destroyed, or relinquished possession of) the computer on which the SOFTWARE was first 
installed and have removed the SOFTWARE from the original computer. If the SOFTWARE is made available on a network, it may be 
accessed only by ONE specific computer. Once the SOFTWARE has been accessed by ONE specific computer it may not be used on 
any additional computers without purchasing additional licenses.

4. NUMBER OF COPIES LICENSED. If you have NOT purchased a DRIVE IMAGE PROFESSIONAL or WORKSTATION 
LICENSE, then you are authorized to use ONLY a single copy of the SOFTWARE on a single computer. If you have purchased a 
DRIVE IMAGE PROFESSIONAL OR A DRIVE IMAGE WORKSTATION LICENSE, refer to the Drive Image Professional or 
Workstation License Agreement for specific terms and conditions. If you purchased a 5, 10, or 20 computer PACK LICENSE, as 
indicated in the Drive Image manual, you are authorized to use the number of copies for which you have paid. In addition to any copies 
authorized for use under this License, you may make a single copy of the SOFTWARE solely for backup purposes. All copies of the 
SOFTWARE must include our copyright notice. To purchase a DRIVE IMAGE PROFESSIONAL OR WORKSTATION LICENSE, 
contact PowerQuest at 1-800-379-2566 or sales@powerquest.com.

5. PERSONAL LICENSE. This license is personal to you. You may not sublicense, lease, sell, or otherwise transfer the SOFTWARE or 
any of the accompanying documentation to any other person. You may use the SOFTWARE only for your own personal use if you are 
an individual, or for your own internal business purposes if you are a business.

6. NONPERMITTED USES. Without the express permission of PowerQuest, you may not (a) use, copy, modify, alter, or transfer, 
electronically or otherwise, the SOFTWARE or documentation except as expressly permitted in this License Agreement, or (b) translate, 
reverse program, disassemble, decompile, or otherwise reverse engineer the SOFTWARE.

7. TERM. This license is effective from your date of purchase and shall remain in force until terminated. You may terminate the license 
and this License Agreement at any time by destroying the SOFTWARE and the accompanying documentation, together with all copies 
in any form.

8. EXPORT CONTROLS. Certain uses of the SOFTWARE by you may be subject to restrictions under U.S. regulations relating to 
exports and ultimate end uses of computer software. You agree to fully comply with all applicable U.S. laws and regulations, including 
but not limited to the Export Administration Act of 1979 as amended from time to time and any regulations promulgated thereunder.
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9. U.S. GOVERNMENT RESTRICTED RIGHTS. If you are acquiring the SOFTWARE on behalf of any unit or agency of the United 
States Government, the following provision applies: It is acknowledged that the SOFTWARE and the documentation were developed at 
private expense and that no part is in the public domain and that the SOFTWARE and documentation are provided with RESTRICTED 
RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights 
in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 
Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Contractor/manufacturer is PowerQuest Corporation/PO Box 
1911/Orem, UT 84059-1911.

10. LIMITED WARRANTY. (a) PowerQuest warrants to you, the original end user, (i) that the SOFTWARE, other than third-party 
software, will perform substantially in accordance with the accompanying documentation and (ii) that the SOFTWARE is properly 
recorded on the disk media. This Limited Warranty extends for ninety (90) days from the date of purchase. PowerQuest does not warrant 
any third-party software that is provided with the SOFTWARE, but PowerQuest agrees to pass on to you any warranties of the owner or 
licensor to the extent permitted by the owner or licensor. (b) This Limited Warranty does not apply to any SOFTWARE that has been 
altered, damaged, abused, mis-applied, or used other than in accordance with this License and any instructions included on the 
SOFTWARE and the accompanying documentation. (c) PowerQuest’s entire liability and your exclusive remedy under this Limited 
Warranty shall be the repair or replacement of any SOFTWARE that fails to conform to this Limited Warranty or, at PowerQuest’s 
option, return of the price paid for the SOFTWARE. PowerQuest shall have no liability under this Limited Warranty unless the 
SOFTWARE is returned to PowerQuest or its authorized representative, with a copy of your receipt, within the warranty period. Any 
replacement SOFTWARE will be warranted for the remainder of the original warranty period or 30 days, whichever is longer. (d) THIS 
WARRANTY IS IN LIEU OF AND EXCLUDES ALL OTHER WARRANTIES NOT EXPRESSLY SET FORTH HEREIN, 
WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR WARRANTIES ARISING FROM USAGE OF TRADE OR COURSE OF 
DEALING. (e) THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, YOU MAY HAVE OTHERS WHICH VARY FROM 
STATE TO STATE. (f) Your failure to return the enclosed registration card may result in PowerQuest’s inability to provide you with 
updates to the SOFTWARE, and you assume the entire risk of performance and result in such event.

11. LIMITATION OF LIABILITY. IN NO EVENT SHALL POWERQUEST’S LIABILITY RELATED TO ANY OF THE 
SOFTWARE EXCEED THE LICENSE FEES ACTUALLY PAID BY YOU FOR THE SOFTWARE. EXCEPT FOR A RETURN OF 
THE PURCHASE PRICE UNDER THE CIRCUMSTANCES PROVIDED UNDER THE LIMITED WARRANTY, NEITHER 
POWERQUEST NOR ITS SUPPLIERS SHALL IN ANY EVENT BE LIABLE FOR ANY DAMAGES WHATSOEVER ARISING 
OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE, INCLUDING BUT NOT LIMITED TO 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND DAMAGES FOR LOSS OF BUSINESS 
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS, EVEN IF 
POWERQUEST CORPORATION HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER SUCH 
LIABILITY IS BASED ON CONTRACT, TORT, WARRANTY, OR ANY OTHER LEGAL OR EQUITABLE GROUNDS. 
BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

12. This License Agreement constitutes the entire agreement between you and POWERQUEST pertaining to its subject matter. This

License Agreement is governed by the laws of the State of Utah. Any litigation arising from this license will be pursued only in the state 
or federal courts located in the State of Utah. 

For further information: Should you have any questions concerning this Agreement, or if you desire to contact PowerQuest Corporation 
for any reason, please write: PowerQuest Corporation/PO Box 1911/Orem, UT 84059-1911. U.S.A.

Copyright © 1994–1998 PowerQuest Corporation. All rights reserved. U.S. Patent 5,675,769 and 5,706,472, with other patents pending.
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Important

 

Read this before using your copy of PowerQuest® Drive Image™

 

PowerQuest Corporation International Software License Agreement

 

This Drive Image License Agreement (“License”) is a legal agreement between you, the “End User,” and PowerQuest Corporation 
(“PowerQuest”). Use of the enclosed software indicates the End User acceptance of these terms. As used in this License, the term 
“SOFTWARE” means the Drive Image software included on the CD or disk media provided with this License. The term “SOFTWARE” 
does not include any software that is covered by a separate license offered or granted by a person other than PowerQuest and this 
License does not grant any rights in such software.

IF THE END USER DOES NOT AGREE TO THESE TERMS AND CONDITIONS, THE END USER MUST EITHER DESTROY 
OR RETURN, INTACT, THE SOFTWARE PACKAGE, CONTAINING THE CDs OR DISK MEDIA, TOGETHER WITH THE 
OTHER COMPONENTS OF THE PRODUCT TO THE PLACE OF PURCHASE.

1. PROPRIETARY RIGHTS. The Software and any associated documentation are proprietary products of PowerQuest or its licensors 
and are protected under U.S. and European copyright, trademark, patent and trade secret laws and international treaty provisions. Sole 
ownership of the SOFTWARE and all copies, modifications, and merged portions thereof shall at all times remain with PowerQuest or 
its licensors.

2. GRANT OF LICENSE. PowerQuest hereby grants to the End User a non-exclusive, non-transferable license to use the SOFTWARE 
in accordance with the terms of this License. The SOFTWARE is considered in use on a computer when it is loaded into temporary 
memory or installed into permanent memory.

3. COMPUTER-SPECIFIC LICENSE. Each permitted copy of the SOFTWARE may be used only in connection with a hard drive(s) 
that is (are) permanently connected to ONE specific computer (either a stand-alone computer or a computer connected to a network) 
owned or leased by the End User. Once a copy of the SOFTWARE has been used on a computer, it may not be used on any other 
computer, unless the End User has permanently stopped using (e.g., sold, destroyed, or relinquished possession of) the computer on 
which the SOFTWARE was first installed and has removed the SOFTWARE from the original computer. If the SOFTWARE is made 
available on a network, it may be accessed only by ONE specific computer. Once the SOFTWARE has been accessed by ONE specific 
computer, it may not be used on any additional computers without purchasing additional licenses.

4. SOFTWARE COPIES LICENSED. If the End User has NOT purchased a DRIVE IMAGE PROFESSIONAL OR WORKSTATION 
LICENSE, the End User is authorized to use ONLY a single copy of the SOFTWARE on a single computer. If the End User has 
purchased a DRIVE IMAGE PROFESSIONAL OR WORKSTATION LICENSE, the End User must refer to the Drive Image 
Professional or Workstation License Agreement for specific terms and conditions. If the End User purchased a 5, 10 or computer PACK 
LICENSE, as indicated in the Drive Image manual, the End User is authorized to use the number of copies for which the End User has 
paid. In addition to any copies authorized for use under this License, the End User may make a single copy of the SOFTWARE solely 
for backup purposes. All copies of the SOFTWARE must include all PowerQuest confidentiality, copyright, trademark and patent 
notices. DRIVE IMAGE PROFESSIONAL OR WORKSTATION LICENSE may be purchased from PowerQuest International Sales at 
+1 (801) 437-8900 or international@powerquest.com.

5. CONFIDENTIALITY AND CONTROL OF THE SOFTWARE. The SOFTWARE, all associated documentation, and all copies are 
secret and confidential to PowerQuest and shall be retained under the effective control of the End User during the period of this License. 
The End User shall take all measures necessary to preserve confidentiality and secrecy in the SOFTWARE during the period of this 
license and after its termination, however such termination may arise.

6. PERSONAL LICENSE. This License is personal (including with respect to corporate entities) to the End User and the End User shall 
not assign or transfer any interest in it or grant any right under it to any third party or seek to exercise this License for the benefit or on 
the data of any third party.
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7. THIRD PARTY SOFTWARE. The rights granted in Paragraphs 3 and 4 do not apply to IBM Boot Manager. The End User may use 
ONE copy of IBM Boot Manager on ONE PC for evaluation purposes only. Additional licenses for IBM Boot Manager may be 
purchased from PowerQuest by contacting PowerQuest International Sales at +1 (801) 437-8900 or international@powerquest.com.

8. UPDATES AND SUPPORT. The End User is entitled to receive 90-days technical support from the date of purchase. Technical 
support shall be limited to telephone or e-mail support from PowerQuest's offices, unless PowerQuest specifically agrees otherwise. The 
End User is entitled to receive SOFTWARE updates (updates are only version number changes to the right side of the decimal) in 
accordance with PowerQuest policies as announced from time to time on terms comparable to those offered to other users of the 
SOFTWARE under the Drive Image Professional and PartitionMagic Professional Licenses.

9. INTEGRITY OF THE SOFTWARE. The End User shall not enhance or vary any part of the SOFTWARE nor procure or permit the 
whole or any part of the SOFTWARE (whether in its original or in any updated, enhanced or varied form) to be incorporated into any 
other software or computer system. Translations, reverse programming, disassembling and reverse engineering of the SOFTWARE are 
expressly prohibited. Provided, however, that nothing in these conditions shall restrict (i) decompilations, notwithstanding that 
decompilation may involve adaptation, if the sole purpose of such decompilation is to achieve the interoperability of an independently 
created program with other programs, or (ii) any other act permitted to the End User by applicable laws and regulations of the End User's 
jurisdiction.

10. TERM AND TERMINATION. (a) This License is effective from the date of purchase of the SOFTWARE and shall remain in force 
until terminated. The End User may terminate this License at any time by destroying the SOFTWARE and its associated documentation, 
together with all copies in any form. (b) Notwithstanding 10(a) above, this License may be terminated at any time by written notice of 
termination given by PowerQuest to the End User in any of the following circumstances: (i) If the End User shall expressly or implied by 
repudiate this License by refusing or threatening to refuse to observe any of the conditions to which this License is subject; or (ii) If the 
End User shall fail to make any payment due under and pursuant to this License or to observe any of the conditions to which this License 
is subject and, after the End User's attention has been drawn by notice to such failure, shall fail to remedy the matter to PowerQuest's 
reasonable satisfaction within thirty days of the giving of such notice; or (iii) If the End User shall have a receiver or administrative 
receiver or administrator appointed or shall enter into liquidation whether compulsory or voluntary or if the End User shall be unable to 
pay its debts as and when they fall due. (c) On expiry, surrender or other termination of this License, however such termination may 
arise, the End User shall cease to load, store, copy or use the Software and the associated documentation, shall delete the SOFTWARE 
from its computers and shall either surrender the SOFTWARE and the associated documentation, together with all copies in any form, to 
PowerQuest or shall destroy the same. The End User shall continue after termination to observe and enforce confidentiality and secrecy 
in respect of the SOFTWARE and its associated documentation for the benefit of PowerQuest, and however termination may occur it 
shall not prejudice any right of action or remedy which may have occurred prior to termination.

11. EXPORT CONTROLS. Certain uses of the SOFTWARE by the End User may be subject to restrictions under U.S. regulations 
relating to exports and ultimate end uses of computer software. The End User agrees to fully comply with all applicable U.S. laws and 
regulations, including but not limited to the Export Administration Act of 1979 as amended from time to time and any regulations 
promulgated thereunder.

12. LIMITED WARRANTY. (a) PowerQuest warrants to the End User, (i) that the SOFTWARE (not including any third-party 
software) will perform substantially in accordance with the associated documentation and (ii) that the SOFTWARE is properly recorded 
on the disk media. This Limited Warranty extends for ninety (90) days from the date of purchase. PowerQuest does not warrant any 
third-party software that is provided with the SOFTWARE, but PowerQuest agrees to pass on to the End User any warranties of the 
owner or licensor to the extent permitted by the owner or licensor. (b) This Limited Warranty does not apply to any SOFTWARE that 
has been altered, damaged, abused, mis-applied, or used other than in accordance with this License and any instructions included on the 
SOFTWARE and the associated documentation. (c) PowerQuest's entire liability under this Limited Warranty shall be the repair or 
replacement of any SOFTWARE. PowerQuest shall have no liability under this Limited Warranty unless the SOFTWARE is returned to 
PowerQuest or its authorized representative, with a copy of the End User's receipt, within the warranty period. Any replacement 
SOFTWARE will be warranted for the remainder of the original warranty period or 30 days, whichever is longer. (d) THIS 
WARRANTY IS IN LIEU OF AND EXCLUDES ALL OTHER WARRANTIES NOT EXPRESSLY SET FORTH HEREIN, 
WHETHER EXPRESS OR IMPLIED, SUBJECT TO CONTRARY ORDRE PUBLIC REQUIREMENTS IN THE END USER'S 
JURISDICTION.

13. INDEMNITIES AND LIMITATION OF LIABILITY. (a) Subject to 13(b) below, PowerQuest warrants to the End User that the 
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Software as supplied by PowerQuest will not infringe any copyright, patent or other intellectual property right of any third party. 
Conditionally upon the End User's promptly giving notice to PowerQuest of any claim of alleged infringement and allowing PowerQuest 
to have sole control of negotiations on, and any defense of the claim, PowerQuest shall in its discretion and at its own cost either 
compromise or defend the claim and shall hold the End User harmless from any resulting final judgment, order or settlement. 
PowerQuest shall have the right to replace or change the SOFTWARE so as to avoid infringement and require the End User to accept a 
license to use such replaced or changed SOFTWARE in substitution for this License, provided that the SOFTWARE as substituted is 
substantially suitable for the End User's utilization. (b) PowerQuest's maximum liability to the End User under 13(a) above shall not 
exceed the License fees actually paid by the End User for the SOFTWARE. If PowerQuest becomes aware of a potential claim under 
13(a) above, PowerQuest shall be entitled then or at any time thereafter to discharge its liabilities (including potential, accruing and 
accrued liabilities) to the End User under 13(a) above by requiring the End User to surrender this License and to cease use of the 
SOFTWARE upon PowerQuest's paying to the End User a sum equivalent to the maximum amount of PowerQuest's liability as stated 
above. (c) GENERAL LIMITATION OF LIABILITY AND INDEMNITIES. POWERQUEST'S MAXIMUM LIABILITY RELATED 
TO ANY OF THE SOFTWARE SHALL NOT EXCEED THE LICENSE FEES ACTUALLY PAID BY THE END USER FOR THE 
SOFTWARE. 

 

FOR AUSTRIA, BELGIUM, CZECH REPUBLIC, FRANCE, HUNGARY, IRELAND, LUXEMBOURG AND THE NETHERLANDS:

 

 IN 
NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF (a) DEATH, PERSONAL 
INJURY OR DAMAGE TO PROPERTY CAUSED BY POWERQUEST'S NEGLIGENCE OR (b) POWERQUEST'S GROSS 
NEGLIGENCE OR WILLFUL MISCONDUCT, FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF 
POWERQUEST'S LIABILITY AS STATED IN 13(b) ABOVE, BY REASON OF ANY REPRESENTATION OR IMPLIED 
WARRANTY, CONDITION OR OTHER TERM OR ANY DUTY AT LAW, OR UNDER THE TERMS OF THIS AGREEMENT, 
FOR ANY CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF 
BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF OR IN CONNECTION WITH ANY ACT OR OMISSION OF 
POWERQUEST RELATING TO THE USE OR INABILITY TO USE THE SOFTWARE BY THE END USER. 

 

FOR GREECE: 

 

IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF DEATH, 
DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S FRAUD OR GROSS NEGLIGENCE, FOR 
AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED IN 13(b) ABOVE, BY 
REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR ANY DUTY AT LAW, 
OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR LOSS 
OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF OR IN 
CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR INABILITY TO USE THE 
SOFTWARE BY THE END USER. 

 

FOR ITALY: 

 

IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF DEATH, 
DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S FRAUD OR GROSS NEGLIGENCE OR 
VIOLATION OF A DUTY ARISING FROM APPLICABLE ORDINE PUBBLICO RULES, FOR AN AMOUNT IN EXCESS OF 
THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED IN 13(b) ABOVE, BY REASON OF ANY 
REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR ANY DUTY AT LAW, OR UNDER THE 
TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR LOSS OF PROFIT, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF OR IN CONNECTION 
WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR INABILITY TO USE THE SOFTWARE BY 
THE END USER. 

 

FOR DENMARK, FINLAND AND NORWAY: 

 

IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT 
(i) IN RESPECT OF DEATH OR PERSONAL INJURY CAUSED BY POWERQUEST'S GROSS NEGLIGENCE OR WILLFUL 
MISCONDUCT OR (ii) IF SUCH LIABILITY LIMITATION IS UNREASONABLE UNDER ALL RELEVANT CIRCUMSTANCES, 
FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED IN 13(b) 
ABOVE, BY REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR ANY 
DUTY AT LAW, OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE 
(WHETHER FOR LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE) 
ARISING OUT OF OR IN CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR 
INABILITY TO USE THE SOFTWARE BY THE END USER. 



 

 

 

viii

 

FOR PORTUGAL: 

 

IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF DEATH, 
DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S GROSS NEGLIGENCE OR WILLFUL 
MISCONDUCT, FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED 
IN 13(b) ABOVE, BY REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR 
ANY DUTY AT LAW, OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE 
(WHETHER FOR LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE AND 
WHETHER OCCASIONED BY POWERQUEST'S NEGLIGENCE OR ITS AGENTS OR OTHER REPRESENTATIVES) ARISING 
OUT OF OR IN CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR INABILITY 
TO USE THE SOFTWARE BY THE END USER. 

 

FOR SPAIN: 

 

IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT OF DEATH, 
DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S BAD FAITH CONDUCT, FOR AN 
AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY AS STATED IN 13(b) ABOVE, BY 
REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR OTHER TERM OR ANY DUTY AT LAW, 
OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR LOSS 
OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF OR IN 
CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING TO THE USE OR INABILITY TO USE THE 
SOFTWARE BY THE END USER. 

 

FOR SWEDEN, SWITZERLAND: 

 

IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT 
OF DEATH, DAMAGE TO PROPERTY OR PERSONAL INJURY CAUSED BY POWERQUEST'S GROSS NEGLIGENCE OR 
WILLFUL MISCONDUCT, FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S LIABILITY 
AS STATED IN 13(b) ABOVE, BY REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, CONDITION OR 
OTHER TERM OR ANY DUTY AT LAW, OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY CONSEQUENTIAL 
LOSS OR DAMAGE (WHETHER FOR LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION 
OR OTHERWISE) ARISING OUT OF OR IN CONNECTION WITH ANY ACT OR OMISSION OF POWERQUEST RELATING 
TO THE USE OR INABILITY TO USE THE SOFTWARE BY THE END USER. 

 

FOR THE UNITED KINGDOM: 

 

IN NO EVENT SHALL POWERQUEST BE LIABLE TO THE END USER, EXCEPT IN RESPECT 
OF (a) DEATH OR PERSONAL INJURY CAUSED BY POWERQUEST'S NEGLIGENCE OR (b) DAMAGE TO PROPERTY OR 
OTHER LOSS CAUSED BY POWERQUEST WHERE SUCH LIABILITY LIMITATION IS UNREASONABLE UNDER ALL 
RELEVANT CIRCUMSTANCES. FOR AN AMOUNT IN EXCESS OF THE MAXIMUM AMOUNT OF POWERQUEST'S 
LIABILITY AS STATED IN 13(b) ABOVE, BY REASON OF ANY REPRESENTATION OR IMPLIED WARRANTY, 
CONDITION OR OTHER TERM OR ANY DUTY AT LAW, OR UNDER THE TERMS OF THIS AGREEMENT, FOR ANY 
CONSEQUENTIAL LOSS OR DAMAGE (WHETHER FOR LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF 
BUSINESS INFORMATION OR OTHERWISE) ARISING OUT OF OR IN CONNECTION WITH ANY ACT OR OMISSION OF 
POWERQUEST RELATING TO THE USE OR INABILITY TO USE THE SOFTWARE BY THE END USER.

14. This License constitutes the entire agreement between the End User and PowerQuest pertaining to its subject matter. This License is 
governed by the laws of the State of Utah (except that body of laws controlling conflict of laws).

For further information: Should the End User have any questions concerning this Agreement, or if the End User desires to contact 
PowerQuest for any reason, please write: PowerQuest Corporation. 1359 North Research Way, Building K/Orem/UT 84097 U.S.A.

Copyright© 1994–1998, PowerQuest Corporation. All rights reserved. U.S. Patent 5,675,769 and 5,706,472, with other Patents Pending.
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About This User Guide

 

This user guide was written to help you set up and run PowerQuest Drive Image. It is 
divided into thirteen parts

The 

 

Introduction

 

 provides an overview of PowerQuest Drive Image and lists the 
hardware and software requirements.

 

Chapter 1: Getting Started

 

 provides step-by-step instructions on preparing to run Drive 
Image.

 

Chapter 2: Menu Options

 

 provides step-by-step instructions on using the drop-down 
menu options on the Drive Image main screen.

 

Chapter 3: Creating Image Files

 

 provides step-by-step instructions and scenarios on 
how to create image files.

 

Chapter 4: Restoring Image Files

 

 provides step-by-step instructions and scenarios on 
how to restore image files.

 

Chapter 5: Copying Disk To Disk

 

 provides step-by-step instructions on how to directly 
copy partitions from one drive to another, without creating an image file.

 

Chapter 6: Drive Image File Editor

 

 provides step-by step instructions on using Drive 
Image File Editor, a utility that allows you to create and copy image files, copy or delete 
partitions within files, compress and uncompress partitions, and restore individual 
program and data files from an image file.

 

Chapter 7: Additional Utilities

 

 provides information on DriveMapper and MagicMover, 
two utilities that are included with Drive Image.

 

Appendix A: Additional Resource Information

 

 reviews creating a bootable DOS 
floppy, loading DOS device drivers from a bootable floppy, and using FDISK and 
FORMAT to create and format partitions. It also provides device driver information, 
common jumper settings, and hard drive manufacturer information.

 

Appendix B: Troubleshooting

 

 provides a reference for Frequently Asked Questions and 
reviews error messages with their solutions.
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Appendix C: PowerQuest Technical Support Contact Information

 

 covers what you 
should do before you contact technical support and provides a form for contacting 
PowerQuest technical support.

The 

 

Glossary 

 

defines common terms found in the Drive Image User Guide.

The 

 

Index 

 

helps you locate the different topics discussed in the Drive Image User Guide.
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Introduction

 

This section contains the following information:

• What is Drive Image? 

• Drive Image Professional Version

• Drive Image System Requirements

 

What is Drive Image?

 

Drive Image is for PC users who want a fast, complete solution for system backups and 
recovery. With Drive Image you can easily create and store a compressible image file of 
an entire hard drive or individual partitions on a Jaz, Zip, secondary hard drive, or other 
removable media device. The image file can then be restored from the source and used for 
complete operating system, application and data recovery.

 

NOTE:

 

Currently, Drive Image does not support creating image files directly on 
CD-R or tape drives. You must first save image files to a supported source 
(hard drive, Zip drive, etc.), then copy them to CD-R or tape. Drive Image 
can, however, directly restore image files from CD-R.

Furthermore, image files can only be saved to devices that have a valid 
drive letter. While Drive Image includes some device drivers (such as 
Zip and SyQuest), the user is primarily responsible for loading the 
necessary drivers for his/her data storage devices so that DOS can 
correctly assign drive letters.

In addition to providing reliable system backup and recovery, Drive Image is an efficient 
means of replicating your system when upgrading to a new hard drive. 

 

NOTE:

 

To use Drive Image to clone multiple workstations see the 

 

Drive Image 
Professional 2.0 Supplement.

 

Using its patent-pending SmartSector technology, Drive Image is up to five to ten times 
faster than straight file-by-file, or sector-by-sector methods of copying because it copies only 
used sectors. This not only speeds up the copy process, it saves valuable disk space as well.
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Drive Image also includes other useful features such as the ability to resize partitions, disk 
to disk copying for upgrading to a larger hard drive, and file system error and bad sector 
checking to prevent copying problems. Context-sensitive online help is available by 
pressing <F1>.

Drive Image supports the file systems of all versions of Windows 95, Windows NT, 
Windows 3.x, DOS, and OS/2 including FAT32, FAT32X, NTFS, and HPFS partition 
types. Because Drive Image understands the internal structure of these file systems, 
partition resizing and fast SmartSector copying can occur.

Drive Image provides limited support for NetWare, Linux, UNIX and other partition 
types. However, Drive Image copies such partitions sector by sector and does not resize 
them on the destination drive, making the image file creation and restore process for these 
file systems more time-consuming. Additionally, internal disk location references are not 
modified on the destination drive. This may make these partitions unbootable or otherwise 
inaccessible. PowerQuest will not support problems caused by NetWare, Linux, or UNIX 
partition types.

Drive Image is a DOS-based program that can be run from the hard drive in DOS or 
MS-DOS mode or from a floppy diskette after booting DOS. Because multi-tasking 
operating systems like Windows 95 and Windows NT operate with open files on the hard 
drive, it is necessary to run Drive Image from DOS so that the image files are an exact 
copy of your hard drive. Only by running in DOS is the hard drive completely inactive 
with no open files.

This Drive Image technology is brought to you by PowerQuest, the makers of PartitionMagic. 
PartitionMagic 3.0 is the revolutionary utility that lets you reclaim wasted disk space, safely 
boot and run multiple operating systems, and organize and protect your data.

 

NOTE:

 

For more information on PartitionMagic, see “Benefits of Using Partition 
Magic” in 

 

Appendix A

 

 (page 89).

 

Drive Image Professional Version

 

If you want the absolute fastest way to clone workstations, a Drive Image Professional 
version is available for use on multiple PCs. For more information contact PowerQuest 
sales at 801-226-8977 or visit our Web site at 

 

http://www.powerquest.com

 

.
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Drive Image System Requirements

 

Drive Image System Requirements  

 

IMPORTANT:

 

Because of operating system conflicts that can result from different hardware 
configurations, Drive Image was not intended to copy or image a hard drive 
that will be used in a system with different hardware configurations.

 

NOTE:

 

You must have Windows 3.x, 95 or NT to run DriveMapper and 
MagicMover. Drive Image File Editor requires Windows 95.

 

Hardware/Software Minimum Recommended

Processor

 

Intel 386SX Intel 486 or above

 

RAM

 

8 MB (16 MB required for 
FAT32 or NTFS)

32 MB (48 MB for FAT32 
partitions larger than 6 GB)

 

3.5-inch diskette drive

 

None 3.5-inch diskette drive

 

CD-ROM drive

 

Any speed Any speed

 

Hard drive free space

 

5 MB 5 MB

 

Operating System

 

Windows 3.x, 95, NT, 
DOS 5.0, OS/2*

Windows 3.x, 95, NT, 
DOS 5.0, OS/2*

 

Monitor

 

VGA SVGA

 

Pointing Device

 

No pointing device is required 
to operate Drive Image.

Microsoft mouse (or 
compatible pointing device)

 

* For Windows NT and OS/2 users, Drive Image must be run from a bootable floppy. For more information, refer to the 
README.TXT file on the Drive Image CD.
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Chapter

 

Getting Started

 

This chapter contains the following information:

• Installing Drive Image 

• Before Using Drive Image

• Loading External Drive Device Drivers from DOS

• Running Drive Image

• Uninstalling Drive Image

 

Installing Drive Image

 

You can install Drive Image from any of the following operating systems:

• Windows 3.x 

• Windows 95 

• Windows NT 

 

NOTE:

 

If you are using DOS or OS/2, see refer to the README.TXT file on the 
Drive Image CD.

To install Drive Image, perform the following:

1. Insert the CD-ROM into your CD-ROM drive.

2. Start the installation program.

1
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a. If you are using Windows 3.x or Windows NT 3.51, select 

 

Run 

 

from the Program 
Manager File menu. Type 

 

drive

 

:\SETUP

 

,

 

 

 

in which 

 

drive 

 

is the drive letter of your 
CD-ROM drive, and click 

 

OK

 

.

b. If you are using Windows 95 or Windows NT 4.0 and if CD auto-run is enabled, 
the installation program automatically launches when you place the Drive Image 
CD in your CD-ROM drive.

A dialog appears containing the following options:

• Install Drive Image

• Install MagicMover

• Create Diskettes

• Technical Support Helps

3. Select the option you want and follow the on-screen instructions.

 

NOTE:

 

On Windows NT or OS/2 systems, Drive Image must be installed to a FAT 
partition and can only be run after booting DOS. If you do not have DOS, 
refer to the README.TXT file on the Drive Image CD-ROM for information 
on creating a DOS bootable floppy.

 

Before Using Drive Image

 

Before using Drive Image, it is important that you perform the following:

• Run a disk utility such as ScanDisk or CHKDSK on each partition of the source drive 
to check for file system errors.

• Verify that each FAT partition containing OS/2 extended attributes has a minimum of 5 
MB of free space within the partition if it will be resized during the restore process.

• Run CHKDSK /F if you are on a Windows NT system.

 

Loading External Drive Device Drivers from DOS

 

In order to use Drive Image with external drives, you must load the external drive device 
drivers from DOS. For specific information on setting up a DOS bootable floppy or loading 
a DOS device driver, contact your manufacturer directly. See the following section for a 
listing of External Drive Manufacturer's Internet addresses.
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Running Drive Image

 

External Drive Manufacturer's Contact Information

 

Iomega: 

 

http://www.iomega.com

 

SyQuest: 

 

http://www.syquest.com

 

Cheyenne: 

 

http://www.cheyenne.com

 

Panasonic: 

http://www.panasonic.com

Installing Device Drivers for Iomega and SyQuest

During Setup, Drive Image allows you to install drivers for Iomega and SyQuest 
removable media.

To install Iomega drivers, simply select Iomega drivers.

To install SyQuest drivers, select SyQuest drivers and the required driver type (EIDE, 
SCSI, IEPP, or SEPP).

Running Drive Image

There are two ways to run Drive Image. You can run Drive Image from a floppy diskette 
or from the hard drive if you booted in DOS or MS-DOS mode. 

Running Drive Image from a Floppy Diskette

If you want to run Drive Image from a floppy diskette, perform the following:

Windows 3.x, Windows 95, and Windows NT

1. Insert a bootable diskette.
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NOTE: Refer to the README.TXT file on the Drive Image CD-ROM for information 
on creating a DOS bootable floppy or a Drive Image program floppy.

2. Reboot your machine.

3. Insert your Drive Image program diskette. Type A:\PQDI and press <ENTER>.

OS/2 and DOS

1. Insert a bootable diskette.

NOTE: Refer to the README.TXT file on the Drive Image CD-ROM for 
information on creating a DOS bootable floppy.

2. Reboot your machine.

Running Drive Image from a Hard Drive

If you want to run Drive Image from your hard drive, perform the following:

1. If you are using Windows 3.x, open the PowerQuest Drive Image program group 
and double-click the Drive Image program icon.

2. If you are using Windows 95, click Start>Programs>Drive Image>PowerQuest 
Drive Image.

NOTE: If you are using Windows NT, you must boot to DOS from a bootable 
floppy. Refer to the README.TXT file on the Drive Image CD-ROM for 
information on creating a DOS bootable floppy.
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Uninstalling Drive Image

Uninstalling Drive Image

To uninstall Drive Image, perform the following:

1. Launch the uninstall program.

a. If you are using Windows 3.x or Windows NT 3.51, double-click the Uninstall 
Drive Image icon in the PowerQuest Drive Image program group.

b. If you are using Windows 95 or Windows NT 4.0, click 
Start>Programs>PowerQuest Drive Image>Uninstall Drive Image.

OR

Click Start>Settings>Control Panel>Add/Remove Programs>Drive Image.

2. Follow the instructions on the screen.
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Chapter

Menu Options

This chapter contains the following information:

• Tools Menu Options

• Help Menu Options

Tools Menu Options

The Tools drop-down menu on the Drive Image main screen lets you manually perform some 
common partition-management tasks that Drive Image automatically performs when it 
processes image files or when it copies partitions. The Tools menu gives you access to these 
useful features without requiring you to create or restore image files, or copy partitions.

Create Extended Partition

If you create an image of a primary partition and want to restore it as a logical partition, 
you must first have an extended partition on your hard drive. (For information on partition 
types and requirements, see Background Information, located in the Windows 95 Start 
menu under Programs>Drive Image 2.0.)

NOTE: It is not necessary to manually create an extended partition when you restore 
an image of a logical partition. Drive Image automatically creates an 
extended partition if one does not already exist.

To create an extended partition, perform the following:

1. At the Drive Image main screen, select Tools>Create Extended Partition.

2
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The Create Extended Partition window appears (see Fig. 2.1).

Fig. 2.1 – Create Extended Partition

2. If you have more than one hard drive on your system, select the desired drive from the 
Physical Drives drop-down list box.

3. Select a free space.

A check mark appears to the left of the selected free space.

NOTE: If there is no free space (unpartitioned area) on your drive, you must 
delete an existing partition to create free space. 

4. Click Create.

Drive Image creates an extended partition in the selected free space.

5. Click Close to return to the Drive Image main screen.

Delete Partition(s)

This feature deletes existing partition(s) to create free space on your hard drive. 

WARNING: Be aware that deleting existing partitions DESTROYS any data they 
contain.
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Tools Menu Options

To delete partition(s), perform the following:

1. At the Drive Image main screen, select Tools>Delete Partition(s).

The Delete Partition(s) window appears (see Fig. 2.2).

Fig. 2.2 – Delete Partitions

2. If you have more than one hard drive on your system, select the desired drive from the 
Physical Drives drop-down list box.

3. Select the partition you wish to delete.

A check mark appears to the left of the selected partition.

4. Click Delete.

The following message appears (see Fig. 2.3): 

“Selected partition:<partition letter>. Deleting this partition will DESTROY any 
existing data! Current volume label is <volume label>. Enter current volume label to 
confirm partition deletion:”
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Fig. 2.3 – Delete Partition Confirmation

Enter the volume label exactly as it appears and click OK . Drive Image deletes the 
partition and displays the message: “Volume <volume name> was deleted successfully.”

5. Click Close to return to the Drive Image main screen.

Hide/Unhide Partition(s)

The Hide/Unhide feature allows you to protect partitions from unwanted user access. 
When you hide a partition, it is not assigned a drive letter the next time you boot your 
computer and therefore, is inaccessible. Alternately, if you unhide a partition, it is assigned 
a drive letter the next time you boot your computer and becomes accessible again.

WARNING: Before hiding and unhiding partitions, be aware of the following:

• Hiding or unhiding a partition can cause the drive letters of subsequent 
partitions to change. This may make the computer fail to boot or cause 
applications to fail. For information on why drive letters change and how to 
fix them, see “How the OS Assigns Drive Letters and Problems Caused by 
Drive Letter Changes” in Background Information. (In Windows 95, 
Background Information is located in the Start menu under 
Programs>Drive Image 2.0.)

• If your hard drive contains more than one primary partition, only one is 
visible by default. When you use the Set Active Partition feature, Drive 
Image unhides the selected primary partition and automatically hides all 
other primary partitions (for more information, see the following section),.
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Tools Menu Options

• Because a hidden partition is not bootable or accessible, if you hide the 
partition where Drive Image is installed, you must re-install Drive Image on 
your new active (bootable) partition to run it again.

To hide/unhide partition(s), perform the following:

1. At the Drive Image main screen, select Tools>Hide/Unhide Partition(s).

The Hide Partition(s) window appears (see Fig. 2.4).

Fig. 2.4 – Hide Partition(s)

2. If you click on a visible partition, the Hide button is available.

a. Click Hide to hide the selected partition.

b. The partition status changes to “Hidden.”

3. If you click on a hidden partition, the Unhide button is available.

a. Click Unhide to unhide the selected partition.

b. The partition status changes to “None.”

4. Click Close to return to the Drive Image main screen.

5. Click Exit  to exit Drive Image.

6. Reboot your computer.
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Set Active Partition

The Set Active Partition feature allows you to make a primary partition the active 
(bootable) partition. Only one primary partition can be active at a time. To be bootable, a 
primary partition must be located on the first (Master) drive, and it must contain an 
operating system. When your computer boots, it scans the partition table of the first drive 
to find the active partition, then boots from that partition.

WARNING: Before you set an active partition, be sure it is bootable. If it is not bootable 
or if you are not sure, locate the boot disk you created when you installed 
Drive Image. If you restart your computer and it does not boot normally, 
you must boot from the floppy disk, run Drive Image from the program disk 
you created during Drive Image install, and set a different active partition.

1. At the Drive Image main screen, select Tools>Set Active Partition.

The Set Active Partition window appears (see Fig. 2.5).

Fig. 2.5 – Set Active Partition

2. Make sure that Disk 1 is selected in the Physical Drives drop-down list box.

3. Select a primary partition that is not currently active.

A check mark appears to the left of the selected partition.

4. Click Set Active.

The status of the selected partition changes to “Active.”
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Help Menu Options

5. Click Close.

6. Click Exit  to exit Drive Image.

7. Reboot your computer.

Help Menu Options

Drive Image provides online help to assist you in performing various tasks. The Help 
Menu at the Drive Image main screen gives you a brief overview of the online help 
system, lets you access the Help Index, and provides information about Drive Image. In 
addition to the Help Menu, you can press <F1> at any time to access the Help Index.

Contents

1. Select Help>Contents to display general instructions for using Drive Image Help.

2. Click Show Index to display a list of all help topics. Double-click a topic to display 
information on that subject.

3. Click Close to exit Help and return to the Drive Image main screen.

About

Select Help>About to display Drive Image’s version, copyright, and patent information 
as well as PowerQuest contact information.
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Chapter

Creating Image Files

This chapter contains the following information:

• Preparation

• Procedure

• Advanced Options

• Scenarios

Preparation

1. Before running Drive Image, use a disk utility program such as ScanDisk or Norton’s 
Disk Doctor to identify and repair any errors on your hard drive.

NOTE: NT users should run CHKDSK /F.

2. You may also choose to run a disk defragmenting utility to further optimize your hard 
drive. 

Procedure

To create an image of the contents of any partition(s), perform the following:

1. At the Drive Image main screen, click Create Image (see Fig. 3.1).

3
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Fig. 3.1 – Drive Image Main Screen

If you have only one hard drive, skip to step 4.

2. If you have more than one hard drive, select the drive that contains the partitions you 
wish to include in the image file (see Fig. 3.2).

A check mark appears to the left of the selected drive.

Fig. 3.2 – Select Source Drive

3. Click Next.

NOTE: At any point prior to actual image file creation, you may click Previous 
to return to the previous step and change your settings.
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Procedure

4. Select the source drive partition(s) you wish to include in the image file, or click 
Select All to automatically select all partitions (see Fig. 3.3).

A check mark appears to the left of the selected partition(s).

Fig. 3.3 – Select Source Partition

To deselect partitions, click again on a partition or click Select None to deselect all 
partitions at once.

The Total Selected field keeps a running total of the disk space for all selected 
partitions, as well as the total used and free space within the partitions.

5. Click Next.

6. Type the desired path and image filename in the Image File field, for example: 
D:\MYIMAGE.PQI (see Fig. 3.4).

NOTE: Drive Image uses .PQI as the default image filename extension.
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Fig. 3.4 – Name Image File

NOTE: You must save your image file to a partition that you are NOT including 
in your image file.

If the drive and directory are not specified in the filename, Drive Image automatically 
saves the image file to the Drive Image program directory, PQDI.

You may also click Browse to browse the directory tree for your desired path and/or 
filename. If you select a pre-existing image file, the following message appears: 

“< Image Filename> exists. Do you want to overwrite it? Yes/No.” If Yes is selected, 
Drive Image immediately deletes the existing file.

You can save your image file to any physical or logical drive which has a drive letter. 
That includes floppy drives, secondary hard drives, network drives, and removable 
media storage devices such as Jaz, Zip, SyQuest drives, etc. (For more information, 
see “Scenarios” on page 23).

7. Click Next.

8. Select the desired compression level (see Fig. 3.5).

• No Compression is the fastest method for creating an image file and is useful if 
storage space is not an issue. (For an exception to this, see the tip on page 19.) 
Drive Image selects No Compression by default.

• Low offers a 40% average compression ratio.

• High offers a 50% average compression ratio.
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Procedure

Fig. 3.5 – Compress Image File

TIP: If you are saving your image file to a busy network drive or to a relatively 
slow removable media device, compression may be faster than no 
compression since there is less data to write to the file.

9. Click Next.

Drive Image displays all the information you have entered to this point (see Fig. 3.6):

• Source Drive

• Source Partitions (partition(s) to be included in the image file are marked with an “X”)

• Image Filename

• Compression Level



Chapter 3: Creating Image Files

20

Fig. 3.6 – Ready to Create Image File

If you wish to modify any settings, click Previous to backtrack and make changes.

10. Click Advanced Options to set such options as disabling file system error-checking 
or password-protecting your image file.

NOTE: For information on Advanced Options settings, see “Advanced 
Options” on page 21.

11. Click Finish to begin creating the image file.

If Drive Image detects that you are saving your image file to a floppy drive or 
removable media, it enables a media-spanning feature that spreads the image file over 
a series of disks. Drive Image permits you to span a maximum of 50 disks with a limit 
of 12 partitions per image file. You must have at least 100K of available space on each 
disk in the series. If you use the media-spanning feature, be sure to number the disks 
in order, since you must insert them in sequence when restoring the image file. For 
more information, see “Creating an Image File on a Zip Drive” on page 23. 

The Creating the Image dialog appears, tracking the following items:

• Image filename

• Estimated megabytes to copy

• Total megabytes copied

• Entire process progress bar
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Advanced Options

• Information about current partition (volume, type, size MB, used MB, free MB)

• Sub-process progress bar

• Transfer rate for current partition

• Total megabytes copied for current partition

• Time elapsed

• Estimated time remaining

Upon completion, the following message appears: “Image was copied successfully to 
file: <image filename>. “

12. Click OK  to return to the Drive Image main screen.

Advanced Options

The Create Image Advanced Options group box appears when you click Advanced 
Options at the Ready To Create Image File screen. The following options are available 
from the Create Image Advanced Options group box (see Fig. 3.7):

Fig. 3.7 – Create Image Advanced Options
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Check for File System Errors

Unmark the Check for File System Errors check box if you want to disable error checking.

If you have already used a disk utility program such as ScanDisk to check your hard drive 
for errors, it is not necessary to have Drive Image check for file system errors. Unmarking 
Check for File System Errors saves time in creating the image file.

If you did not run a disk utility program before loading Drive Image, leave the Check for 
File System Errors check box marked.

Disable SmartSector Copying

Drive Image’s SmartSector technology speeds up the data copying process by only 
copying clusters and sectors that contain data. However, in some cases, such as 
high-security environments, it may be desirable to copy all clusters and sectors in their 
original layout, whether or not they contain data.

If you wish to copy both used and unused clusters and sectors, mark the Disable 
SmartSector Copying check box.

NOTE: Disabling SmartSector copying increases processing time.

Verify Disk Writes

Mark the Verify Disk Writes  check box if you want to enable DOS disk write 
verification.

NOTE: Disk write verification is not critical to safely create image files. Enabling 
disk write verification can slow the image file create process by as much as 
seven times.

ImageShield

If you wish to password-protect your image file, mark the Password Protect Image File 
check box and type a password in the Password field.

IMPORTANT: Be sure to note image file passwords and store them in a safe place. If 
you forget an image file’s password, you cannot restore the file.
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Scenarios

Split Image File Into Multiple Files

Because Drive Image does not directly support CD-R, it cannot span large image files 
over several CDs. Therefore, you must force Drive Image to split the large file into 
smaller, discrete files which you can save to CDs after you exit Drive Image (see 
“Creating an Image File on CD-ROM” on page 25).

To force Drive Image to split large image files into smaller files, mark the Split Image 
File Into Multiple Files  check box and enter the maximum byte size for each file in the 
File Size (bytes) field. If you wish to save the files to CDs, specify a file size of 
650,000,000 bytes (650 MB) or less.

Image File Comments

You can type brief comments about your image file in the Image File Comments field.

Scenarios

Creating an Image File on a Zip Drive

Sample System Configuration

One 1.2 GB hard drive containing:

• One active primary partition (C:) running Windows 95; 300 MB used and 500 MB 
unused.

• One extended partition containing one logical partition (D:); 400 MB used and 0 MB 
unused.

One Zip drive (E:).

Objective

Create an image file of your hard drive’s logical partition (D:) and store it on your Zip drive.

Procedure

1. When you run Setup to install Drive Image on your computer, select the option to 
install Iomega drivers.
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2. Since the image file will be too large to fit on one Zip disk, you must create a series of 
Zip disks.

Label the first Zip disk as “MYIMAGE DISK #1”. During the image file creation 
process, Drive Image prompts you to insert new disks as needed. Label each 
successive disk “MYIMAGE DISK #2”, “MYIMAGE DISK #3”, etc.

3. Run ScanDisk to identify and repair any errors on the D: partition.

4. Run Drive Image.

As Drive Image automatically loads the Zip drivers, be sure to note the drive letter 
assigned to the Zip drive. In this case, we are referring to the Zip drive as E:.

5. Insert the Zip disk labeled “MYIMAGE DISK #1” into your Zip drive.

6. From the title screen, click Create Image.

7. Disk 1 (your hard drive) should already be selected.

8. Click Next.

9. Select the logical partition (D:).

10. Click Next.

11. In the Image File field, type E:\MYIMAGE.PQI .

12. Click Next.

13. Select High compression.

High compression compacts the image of your 400 MB logical partition by 
approximately 50%.

14. Click Next.

15. From the Ready To Create Image File screen, click Advanced Options.

16. Unmark the Check for File System Errors box.

17. Click OK .
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Scenarios

18. Click Finish.

19. When Drive Image prompts you to insert the next disk in the series, wait until the 
busy light on the Zip drive goes out, remove “MYIMAGE DISK #1” from the Zip 
drive, and insert “MYIMAGE DISK #2”.

20. After Drive Image has completed the image create process, click OK  to return to the 
Drive Image main screen and exit the program.

Result

Your 400 MB logical partition is stored on two or more Zip disks (depending on how 
much data was in the partition(s) in a spanned image file. You can restore this logical 
partition to any hard drive that has at least 400 MB of available space.

Storing an Image File on CD-R

Sample System Configuration

One 3 GB hard drive containing:

• One active primary partition (C:) running Windows 95; 1.5 GB used and 300 MB unused.

• One extended partition containing one logical partition (D:); 1.2 GB unused.

One CD-R drive (E:).

Objective

Create an image file of your hard drive’s active primary partition (C:) and store it on CD-R.

Procedure

1. Since the image file will be too large to fit on one CD, you must create a series of two 
CDs.

Label the first CD as “MYIMAGE DISK #1” and the second as “MYIMAGE DISK #2”.

2. Run ScanDisk to identify and repair any errors on your C: partition.

3. Run Drive Image.

4. From the Drive Image title screen, click Create Image.
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5. Disk 1 (your hard drive) should already be selected.

6. Click Next.

7. Select the active primary C: partition.

8. In the Image File field, type D:\MYIMAGE.PQI .

Because Drive Image does not directly support CD-R, you must first save the image 
file to a partition on your hard drive, a secondary hard drive, a network drive, or a 
removable media device. In this scenario, you must save MYIMAGE.PQI to the D: 
partition because Drive Image locks the partition you are imaging (C:) in order to get 
an accurate image.

NOTE: If you have only one hard drive and only one partition on that drive, use 
PartitionMagic to resize your existing partition and to create a logical 
partition that is large enough to accommodate the image file.

9. Click Next.

10. Select Low compression.

Low compression compacts the image of your 1.8 GB primary partition by 
approximately 40%. 

11. Click Next.

12. From the Ready To Create Image File screen, click Advanced Options.

13. Unmark the Check for File System Errors box.

14. Mark the Split Image File Into Multiple Files check box and enter 650,000,000 in 
the File Size (bytes) field.

15. Click OK .

16. Click Finish.

17. After Drive Image has completed the image create process, click OK  to return to the 
Drive Image main screen and exit the program.
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18. Start Windows 95 and open the D: drive from Windows Explorer.

You will find two separate image files, MYIMAGE.PQI and MYIMAGE.002, on your 
D: drive.

19. Using a third-party CD authoring program, such as Adaptec’s CD Creator, burn 
MYIMAGE.PQI into your CD labeled “MYIMAGE DISK #1” and MYIMAGE.002 
into the CD labeled “MYIMAGE DISK #2”.

Result

Your 1.8 GB primary partition is stored on two CD-ROMs in two separate image files. 
You can restore this primary partition to any hard drive that has at least 1.8 GB of 
available space.

Creating an Image File on a Secondary Hard Drive

Sample System Configuration

Disk 1 — One 3.5 GB hard drive containing:

• One active primary partition (C:) running Windows 95; 500 MB used and 1 GB unused.

• One extended partition containing one logical partition (E:); 400 MB used and 600 MB 
unused.

• 1 GB unpartitioned free space.

Disk 2 — One 2 GB hard drive containing:

• One primary partition (D:); 1 GB unused.

• One extended partition containing one logical partition (F:); 600 MB used and 400 MB 
unused.

Objective

Create an image file of the 1 GB logical partition (E:) that is on Disk 1 and store it in the 
primary partition (D:) on Disk 2.

1. Run ScanDisk to identify and repair any errors on both hard drives.

2. Run Drive Image.

3. From the Drive Image title screen, click Create Image.
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4. Select Disk 1.

5. Click Next.

6. Select the E: partition.

7. Click Next.

8. In the Image File field, type D:\MYIMAGE.PQI .

9. Select No Compression.

No Compression is the fastest method for creating an image file. You may use it if 
space is not an issue.

10. Click Next.

11. From the Ready To Create Image File screen, click Advanced Options.

12. Unmark the Check for File System Errors box.

13. Click OK .

14. Click Finish.

15. After Drive Image has completed the image create process, click OK  to return to the 
Drive Image main screen and exit the program.

Result

An image of your 1 GB logical partition (E:) from Disk 1 is stored in an image file named 
MYIMAGE.PQI on the primary partition (D:) of Disk 2. You can restore the logical 
partition to any hard drive that has at least 1 GB of available space.
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Chapter

Restoring Image Files

This chapter contains the following information:

• Preparation

• Procedure

• Resize Options

• Advanced Options

• Scenarios

Preparation

If you are restoring an image file to setup a new hard drive on a machine with a BIOS 
older than 1994, see “Using Drive Image With Older Computer BIOSes that Require 
Drive Overlay Software” in Appendix A.

Procedure

To restore an image file to any drive, perform the following:

1. At the Drive Image main screen, click Restore Image.

2. In the Image File field, enter the complete filename of the image file you wish to 
restore, or click Browse to browse the directory tree for the desired path and image 
filename (see Fig. 4.1).

4
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Fig. 4.1 – Select Image File

3. Click Next.

NOTE: At any point prior to actual image file restore, you may click Previous 
to return to the previous step and change your settings.

4. Select the image file partition(s) you wish to restore, or click Select All to 
automatically select all partitions.

A check mark appears to the left of the selected partition(s) (see Fig. 4.2).

Fig. 4.2 – Select Image File Partition
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Procedure

To deselect partitions, click again on a partition or click Select None to deselect all 
partitions at once.

The Total Selected field keeps a running total of the disk space for all selected 
partitions, as well as the total used and free space within the partitions.

5. Click Next.

6. Select the drive to which you want to restore the image file (see Fig 4.3).

Fig. 4.3 – Select Destination Drive

7. Click Next.
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8. Select an existing partition or free space (non-partitioned disk space) (see Fig 4.4).

Fig. 4.4 – Select Destination Partition or Free Space

9. If the destination partition or free space is not large enough to accommodate the 
partition(s) you wish to restore, or if you are restoring the image file to a larger drive 
and want to set a specific size for partitions rather than use the proportional resize 
option, you can click Resize Partitions to specify different sizes for restored 
partitions. To resize partitions, perform the following:

a. Click Resize Partitions.

The Resize Partitions window appears (see Fig. 4.5).

Fig. 4.5 – Resize Partitions: Main Window
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Procedure

The Selected Source Partitions group box displays the partition(s) you selected to 
restore.

The Totals field displays the disk space for the source partition(s), as well as the 
total used and free space within the partition(s).

A formula box below the Totals field displays the following information:

• Destination Size

• Current Size of Selected Partition

• Remaining Space in Destination

b. Click Resize.

The Resize Partition window appears (see Fig. 4.6).

Fig. 4.6 – Resize Partition: Enter New Size

The Maximum Size field displays the largest possible size the source partition(s) 
can have and still fit in the destination space.

The Minimum Size field shows the smallest possible size the source partition(s) 
can occupy.

c. In the New Size field, enter a number that is less than the Maximum Size and 
greater than or equal to the Minimum Size.

d. Click OK .

Since partitions must end on a cylinder boundary, Drive Image rounds the New 
Size up to the next cylinder boundary.

e. Click Accept.

Later, when you restore the image file, Drive Image resizes the partition.
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10. Click Next.

If you selected an existing partition as the destination, the following message appears 
(see Fig. 4.7): 

“Item selected is not free space. Disk Images can only be restored into existing free 
space. Drive Image will delete this partition before restoring disk image. WARNING: 
Deleting a partition will DESTROY any existing data on that partition.” 

Drive Image does not delete the partition until you click Finish on the Ready to 
Restore Image File screen.

Fig. 4.7 – Delete Partition to Create Free Space: Confirmation Dialog

If the free space on the destination drive is greater than the space required to restore 
the selected partition(s), the Resize Options dialog appears.

NOTE: For information about resize option settings, see “Resize Options” 
(page 36).

11. Drive Image displays all the information you have entered to this point (see Fig. 4.8):

• Image filename

• Selected image file partitions

• Destination drive

• Destination space
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Fig. 4.8 – Ready to Restore Image File

If you wish to alter any settings, click Previous to backtrack and make changes.

12. If you wish to enable bad-sector checking or hide partition(s) after restore, click 
Advanced Options.

For information on Advanced Options settings, see “Advanced Options” (page 37).

WARNING: Restoring multiple logical partitions can cause the drive letters 
of subsequent partitions to change. This may make the 
computer unbootable or cause applications to fail. For 
information on why drive letters change and how to fix them, 
refer to Background Information: “How the OS Assigns Drive 
Letters” and “Problems Caused by Drive Letter Changes.” (In 
Windows 95, Background Information is located in the Start 
menu under Programs>Drive Image 2.0.)

13. Click Finish to begin restoring the image file.

If you assigned a password to the image file when you created it, the Get Image File 
Password dialog appears. You must enter the password in order to restore the image file.

If Drive Image detects that you are restoring your image file from a floppy drive or 
removable medium, it enables a media-spanning feature that is capable of reading the 
image file from a series of disks. As Drive Image prompts you for each disk, be 
careful to insert the disks sequentially. For more information, see “Restoring an 
Image File from a Zip Drive” on page 38. 
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The Restoring the Image dialog appears, tracking the following items:

• Image filename

• Estimated megabytes to restore

• Total megabytes copied

• Entire process progress bar

• Information about current partition (volume, type, size MB, used MB, free MB)

• Sub-process progress bar

• Transfer rate for current partition

• Total megabytes copied for current partition

• Time elapsed

• Estimated time remaining

Upon completion, the following message appears: “Image was restored successfully.”

14. Click OK  to return to the Drive Image main screen.

Resize Options

The following options are available when restoring partitions if the free space on the 
destination drive is greater than the space required by the partition(s).

Fig. 4.9 – Resize Options
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Advanced Options

Automatically resize partitions proportionally to fit.

Mark this option to allow Drive Image to automatically expand the partitions in equal 
proportions to occupy the destination drive’s remaining free space.

Leave remaining free space.

Mark this option if you want to leave any remaining free space unused on the destination 
drive after the partitions are restored.

Resize partitions manually to fit.

Mark this option to display the Resize Partition window where you can manually set the 
size of the partitions to fit in the destination drive’s remaining free space.

NOTE: For more information on resizing partitions, see step 9 of the “Procedure” 
section (page 29).

Advanced Options
The Restore Image Advanced Options group box appears when you click Advanced 
Options at the Ready To Restore Image File screen. The following options are available 
from the Restore Image Advanced Options group box:

Fig. 4.10 – Restore Image Advanced Options



Chapter 4: Restoring Image Files

38

Skip Bad Sector Check

This is marked by default to save time in restoring the image file.

Although most drives do not have bad sectors, the potential for problems increases during 
the lifetime of the hard drive. If you have an older hard drive, it is wise to enable 
bad-sector checking by removing the mark from the Skip Bad Sector Check box.

Verify Disk Writes

Mark the Verify Disk Writes  check box if you want to enable DOS disk write 
verification.

NOTE: Disk write verification is not critical to safely restore image files. Enabling 
disk write verification can slow the image restore process by as much as 
seven times.

Hide Partition After Restore

Most operating systems only allow one primary partition to be visible (bootable) at a time. 
If you are restoring an image of a primary partition and you do not want to make that 
partition your visible (bootable) partition, mark the Hide Partition After Restore box.

Scenarios

Restoring an Image File from a Zip Drive

Sample System Configuration

One 2.1 GB hard drive containing:

• One active primary partition (C:) running Windows 95; 600 MB used and 500 MB 
unused.

• 1 GB unpartitioned free space.

One CD-ROM drive (D:).

One Zip drive (E:).
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Scenarios

Objective

Restore a 400 MB logical partition from an image file (MYIMAGE.PQI) that spans two 
Zip disks. You wish to restore the logical partition to the unpartitioned free space on your 
hard drive and to resize it to 1 GB.

Procedure

1. Run Drive Image.

As Drive Image automatically loads the Zip drivers, be sure to note the drive letter 
assigned to the Zip drive. In this case, we will refer to the Zip drive as E:.

2. From the Drive Image title screen, click Restore Image.

3. Insert the Zip disk you labeled as “MYIMAGE DISK #1” into your Zip drive.

4. In the Image File field, type E:\MYIMAGE.PQI .

You may also click Browse to browse the directory tree for your Zip drive and the 
desired image file.

5. Click Next.

6. Select the 400 MB logical partition.

7. Click Next.

8. Disk 1 should already be selected.

9. Click Next.

10. Select the 1 GB unpartitioned free space.

11. Click Next.

12. When the Resize Options window appears, select Automatically resize partitions 
proportionally to fit , then click OK.

13. Click Finish.

14. When Drive Image prompts you to insert the next disk in the series, remove 
“MYIMAGE DISK #1” from the Zip drive and insert “MYIMAGE DISK #2”.
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15. After Drive Image has completed the image restore, click OK  to return to the Drive 
Image main screen and exit the program.

16. Reboot your computer.

Result

After reboot, your hard drive has an active primary partition (C:) and an extended partition 
containing a 1 GB logical partition (D:). Your CD-ROM is now drive E: and your Zip 
drive is F:.

Restoring an Image File from a CD-R Drive

Sample System Configuration

One 3 GB hard drive containing:

• One damaged, unbootable active primary partition (C:) containing Windows 95; 1 GB 
used and 800 MB unused.

• One extended partition containing one logical partition (D:); 1.2 GB unused.

One CD-R drive (E:).

Objective

Replace your damaged active primary partition (C:) with a backup image of the partition 
stored on CD-ROM.

Procedure

IMPORTANT:  You must copy the DOS drivers for your CD-R onto the bootable floppy 
that you created during Drive Image installation. Refer to your CD-R user guide or contact 
your CD-R manufacturer for instructions on loading CD-R drivers in DOS and making 
DOS assign the CD-R drive a letter.

1. Insert the bootable floppy and start the computer.

2. When the computer has booted to the A: prompt, insert the Drive Image program 
floppy you created during Drive Image installation.

3. At the A: prompt, type PQDI and press <ENTER>.

4. From the Drive Image title screen, click Restore Image.
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Scenarios

5. Insert the CD-ROM you labeled as “MYIMAGE DISK #1” into your CD-R drive.

6. In the Image File field, type E:\MYIMAGE.PQI .

You may also click Browse to browse the directory tree for your CD-R drive and the 
desired image file.

7. Click Next.

8. Select the 1.8 GB primary partition (C:).

9. Click Next.

10. Disk 1 should already be selected.

11. Click Next.

12. Select the 1.8 GB damaged primary partition (C:) on your hard drive.

13. Click Next.

The following message appears: 

“Item selected is not free space. Disk Images can only be restored into existing free 
space. Drive Image will delete this partition before restoring disk image. WARNING: 
Deleting a partition will DESTROY any existing data on that partition.”

14. Click OK .

Drive Image deletes the C: partition and labels it as free space.

15. Click Finish.

16. When Drive Image prompts you to insert the next disk in the series, remove 
“MYIMAGE DISK #1” from the CD-R drive and insert “MYIMAGE DISK #2”.

17. After Drive Image has completed the image restore, it prompts you to select a primary 
partition to set active (bootable). Select the partition you just restored.

18. Click OK  to return to the Drive Image main screen and exit the program.

19. Reboot your computer.
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Result

The restored primary partition (C:) has replaced the damaged active primary partition (C:). 
You should now be able to boot to Windows 95 and operate normally again. Your C: partition 
contains all the data that was present on it when you originally created the image file.

Restoring an Image File from a Secondary Hard Drive

Sample System Configuration

Disk 1 — One 3.5 GB hard drive containing:

• One active primary partition (C:) running Windows 95; 500 MB used and 1 GB 
unused.

• One extended partition containing one logical partition (E:); 400 MB used and 600 MB 
unused.

• 1 GB unpartitioned free space.

Disk 2 — One 2 GB hard drive containing:

• One primary partition (D:); 1 GB used by the image file, MYIMAGE.PQI, and 0 MB 
unused.

• One extended partition containing one logical partition (F:); 600 MB used and 400 MB 
unused.

Objective

Restore the 1 GB logical partition from the image file, D:\MYIMAGE.PQI to the 
unpartitioned free space on Drive 1.

Procedure

1. Run Drive Image.

2. From the Drive Image title screen, click Restore Image.

3. In the Image File field, type D:\MYIMAGE.PQI .

You may also click Browse to browse the directory tree for your secondary drive and 
the desired image file.

4. Click Next.
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Scenarios

5. Select the 1 GB logical partition.

6. Click Next.

7. Select Disk 1.

8. Click Next.

9. Select the 1 GB unpartitioned free space.

10. Click Next.

11. Click Finish.

12. After Drive Image has completed the image restore, click OK  to return to the Drive 
Image main screen and exit the program.

13. Reboot your computer.

Result

After reboot, Disk 1 has a 1.5 GB active primary partition (C:) and an extended partition 
containing two 1 GB logical partitions (E: and F:). Disk 2 has a 1 GB primary partition 
(D:) and an extended partition containing one 1 GB logical partition (G:).



45

Chapter

Copying Disk to Disk

This chapter contains the following information:

• Preparation

• Procedure

• Resize Options

• Advanced Options

• Scenarios

Preparation

1. If you are upgrading to a new hard drive, refer to Appendix A for the following 
information:

• Hard Drive Manufacturer’s Contact Information

• Using Drive Image with SCSI Hard Drives

• Using Drive Image with Older Computer BIOSes that Require Drive Overlay 
Software

2. It is strongly recommended that you perform the following steps before upgrading to 
a new hard drive or using Drive Image to copy disk to disk.

a. Create a bootable DOS diskette.

NOTE: For information on creating a bootable floppy, see the 
README.TXT file on the Drive Image CD-ROM.

5
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b. Before running Drive Image, use a disk utility program such as ScanDisk or 
Norton’s Disk Doctor to identify and repair any errors on your hard drive.

c. Verify that the destination drive or partition is the same size or larger than the 
source drive.

3. If you are copying from one partition to another partition on the same hard drive, skip 
directly to the “Procedure” section.

4. To set up a dual hard drive system, perform the following:

a. Get the manufacturer’s installation guides for both drives.

The installation guides provide information on installing the drives, setting up the 
BIOS, and changing the jumper settings. If you do not have access to these guides, 
contact the hard drive manufacturers directly. Most drive manufacturers maintain 
sites on the World Wide Web that offer setup information. For a contact list of 
some popular hard drive manufacturers, refer to “Hard Drive Manufacturer 
Contact Information” in Appendix A.

b. Turn off the computer’s power.

c. Discharge static electricity by touching a grounded metal object such as a metal 
filing cabinet.

WARNING: Do not allow static electricity to contact the inner parts of 
your computer. Static electricity can damage or destroy 
your computer’s electronic components.

d. Remove the computer’s cover.

e. Determine which drive you want to be Master and which drive you want to be 
Slave, then follow the manufacturer’s instructions to change the jumper settings on 
your hard drives accordingly.

f. Attach the interface cable and the power supply cable to the second drive.

g. Mount the second drive.

h. Start the computer and enter its Basic Input/Output System (BIOS) Setup program 
before the computer completes startup.

This is usually accomplished by pressing <DEL>, <F1>, or <F2>, according to the 
prompt that appears at the bottom of your screen during initial startup.
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Procedure

i. If the BIOS Setup program includes an Auto-Detect option, select it to detect both 
the Master and Slave drives.

If there is no Auto-Detect option, you may be required to enter the specific number 
of heads, cylinders, and megabytes of the drives. This information is usually 
printed on the drive’s outside cover. If it is not, contact the drive manufacturer. 
(See “Hard Drive Manufacturer Contact Information” in Appendix A.)

j. If the BIOS does not support hard drives larger than 504 megabytes, follow the 
destination drive manufacturer’s instructions to install any software included with 
the drive.

IMPORTANT: Computer BIOSes made before 1994 usually do not support 
the EIDE standard and cannot address hard drives larger than 
504 MB. Hard drives larger than 504 MB typically include 
software such as OnTrack Disk Manager, Maxtor Max-Blast 
Disk Manager, or Micro House EZ-Drive which allow 
computers to see larger hard drives.

If your machine does not support the EIDE standard, make sure the software 
included with the destination drive is correctly installed.

When running Drive Image, make sure that the disk sizes reported in the Total 
Selected fields are accurate before continuing. If Drive Image lists a drive size 
that is much smaller than its actual size, the EIDE support software is not 
functioning properly.

k. Turn off the computer and restart it.

Procedure
NOTE: Please be aware that it is NOT necessary to format your destination partition 

or to partition your hard drives before performing a Disk To Disk Copy. 
Drive Image automatically performs both these functions.

To directly copy partitions within the same drive or from one hard drive to another 
without creating an image file, perform the following:

1. At the Drive Image main screen, click Disk To Disk.

2. Select the drive that contains the partition(s) you wish to copy (see Fig. 5.1).

A check mark appears to the left of the selected drive.
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Fig. 5.1 – Select Source Drive

3. Click Next.

NOTE: At any point prior to actually copying partitions, you may click 
Previous to return to the previous step and change your settings.

4. Select the source partition(s) you wish to copy, or click Select All to automatically 
select all partitions (see Fig. 5.2).

A check mark appears to the left of the selected partition(s). 

Fig. 5.2 – Select Source Partition(s)
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Procedure

To deselect partitions, click again on a partition or click Select None to deselect all 
partitions at once.

The Total Selected field keeps a running total of the disk space for all selected 
partitions, as well as the total used and free space within the partitions.

IMPORTANT: In order to copy partitions, the destination partition or drive must 
have free space equivalent to the total space (used and unused) of 
the selected source partition(s).

5. Click Next.

6. Select the drive to which you wish to copy the partition(s) (see Fig. 5.3).

Fig. 5.3 – Select Destination Drive

7. Click Next.
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8. Select an existing partition or free space (non-partitioned disk space) on the 
destination drive (see Fig. 5.4).

Fig. 5.4 – Select Destination Partition or Free Space

NOTE: If your destination drive is new and does not contain any partitions, 
disregard this step.

9. If the destination partition or free space is not large enough to accommodate the 
partition(s) you wish to copy, or if you are copying the partition to a larger drive and 
want to set a specific size for partition rather than use the proportional resize option, 
you can click Resize Partitions to specify a different size for the copied partition. To 
resize partitions, perform the following:

a. Click Resize Partitions.

The Resize Partitions window appears (see Fig. 5.5).
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Procedure

Fig. 5.5 – Resize Partitions: Main Window

The Selected Source Partitions group box displays the partition(s) you selected to 
copy.

The Totals field displays the disk space for the selected partition(s), as well as the 
total used and free space within the partition(s).

A formula box below the Totals field displays the following information:

• Destination Size

• Current Size of Selected Partition

• Remaining Space in Destination

b. Click Resize.

The Resize Partition window appears (see Fig. 5.6).

Fig. 5.6 – Resize Partition: Enter New Size
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The Maximum Size field displays the largest possible size the source partition(s) 
can be and still fit in the destination space.

The Minimum Size field shows the smallest possible size the source partition(s) 
can occupy.

c. In the New Size field, enter a number that is less than the Destination Size (from 
the previous dialog’s formula box) and greater than the Minimum Size.

d. Click OK .

Since partitions must end on a cylinder boundary, Drive Image rounds the New 
Size up to the nearest cylinder boundary.

e. Click Accept.

Later, when you copy the partition(s), Drive Image resizes them.

10. Click Next.

If you selected an existing partition as the destination, the following message appears: 

“Item selected is not free space. Partitions can only be copied into existing free space. 
Drive Image will delete this partition before copying. WARNING: Deleting a 
partition will DESTROY any existing data on that partition.”

Drive Image does not delete the partition until you click Finish on the Ready to 
Copy Disk to Disk screen.

If the free space on the destination drive is greater than the space required to copy the 
selected partition(s), the Resize Options dialog appears.

NOTE: For information on resize option settings, see “Resize Options” (page 54).

11. Drive Image displays all the information you have entered to this point (see Fig. 5.7):

• Source drive

• Source partitions

• Destination drive

• Destination space
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Procedure

Fig. 5.7 – Ready to Copy Disk to Disk

If you wish to alter any settings, click Previous to backtrack and make changes.

12. If you wish to set options such as disabling file system error-checking or hiding 
partitions after copy, click Advanced Options.

NOTE: For information on Advanced Options settings, see “Advanced 
Options” (page 55).

NOTE: Copying multiple logical partitions can cause the drive letters of 
subsequent partitions to change. This may make the computer 
unbootable or cause applications to fail. For information on why drive 
letters change and how to fix them, refer to Background Information: 
“How the OS Assigns Drive Letters” and “Problems Caused by Drive 
Letter Changes.” (In Windows 95, Background Information is located in 
the Start menu under Programs>Drive Image 2.0.)

13. Click Finish to begin copying the selected partition(s).

The Copying Disk To Disk dialog appears, tracking the following items:

• Estimated megabytes to copy

• Total megabytes copied

• Entire process progress bar

• Information about current partition (volume, type, size MB, used MB, free MB)
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• Sub-process progress bar

• Transfer rate for current partition

• Total megabytes copied for current partition

• Time elapsed

• Estimated time remaining

Upon completion, the following message appears: “Selected partition(s) copied 
successfully.”

14. Click OK  to return to the Drive Image main screen.

Resize Options

The following Resize Options are available when copying partitions if the free space on 
the destination drive is greater than the space required by the partition(s).

Fig. 5.8 – Resize Options

Automatically resize partitions proportionally to fit.

Mark this option to allow Drive Image to automatically expand the partitions in equal 
proportions to occupy the destination drive’s remaining free space.
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Advanced Options

Leave remaining free space.

Mark this option if you want to leave any remaining free space unused on the destination 
drive after the partitions are copied.

Resize partitions manually to fit.

Mark this option to display the Resize Partition window where you can manually set the 
size of the partitions to fit in the destination drive’s remaining free space.

NOTE: For more information on resizing partitions, see step 7 of the “Procedure” 
section (page 49).

Advanced Options

The Disk to Disk Advanced Options group box appears when you click Advanced 
Options at the Ready To Copy Disk To Disk screen. The following options are available 
from the Disk To Disk Advanced Options group box:

Fig. 5.9 – Disk to Disk Advanced Options
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Source Options

Check for File System Errors

Unmark the Check for File System Errors check box if you want to disable error 
checking.

If you have already used a disk utility program such as ScanDisk to check your hard drive 
for errors, it is not necessary to have Drive Image check for file system errors. Unmarking 
Check for File System Errors saves time in copying data.

If you did not run a disk utility program before loading Drive Image, leave the Check for 
File System Errors check box marked.

Disable SmartSector Copying

Drive Image’s SmartSector technology speeds up the data copying process by only 
copying clusters and sectors that contain data. However, in some cases, such as 
high-security environments, it may be desirable to copy all clusters and sectors in their 
original layout, whether or not they contain data.

If you wish to copy both used and unused clusters and sectors, mark the Disable 
SmartSector Copying check box.

NOTE: Disabling SmartSector copying increases processing time.

Destination Options

Skip Bad Sector Check

Although most drives do not have bad sectors, the potential for problems increases during 
the lifetime of the hard drive. If you have an older hard drive, it is wise to enable 
bad-sector checking by removing the mark from the Skip Bad Sector Check box.

Verify Disk Writes

Mark the Verify Disk Writes  check box if you want to enable DOS disk write 
verification.

Disk write verification is not critical to safely copy partitions. Enabling disk write 
verification can slow the copying process by as much as seven times.
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Scenarios

Hide Partition After Copy

Most operating systems only allow one primary partition to be visible (bootable) at a time. 
If you are copying a primary partition and you do not want to make that partition your 
visible (bootable) partition, mark the Hide Partition After Copy box.

Also, if you are using your secondary hard drive as a complete backup of your primary 
drive, marking the Hide Partition After Copy  box preserves all the secondary drive 
information without changing any drive letters.

Scenarios

Copying from Partition to Partition in a Single Hard Drive System

Sample System Configuration

One 2 GB hard drive containing one active primary partition (C:) running Windows 95; 
500 MB used and 1.5 GB unused.

Objective

Create a backup of the active partition by copying it to the same hard drive.

Procedure

1. Use PowerQuest’s PartitionMagic to resize the existing primary partition to about 
half the total size of the hard drive (1 GB).

2. Run Drive Image.

3. From the Drive Image title screen, click Disk To Disk.

4. Disk 1 should already be selected.

5. Click Next.

6. Select the primary partition (C:).

7. Click Next.

8. Disk 1 should already be selected.
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9. Click Next.

10. Select the free space (non-partitioned disk space) you created when you resized the 
primary partition.

11. Click Next.

If the Resize Options window appears, select Automatically resize partitions 
proportionally to fit , then click OK.

12. From the Ready To Copy Disk To Disk screen, click Advanced Options.

13. Under the Source Options, unmark the Check for File System Errors box.

14. Under the Destination Options, mark the Hide Partition After Copy  box.

15. Click OK .

16. Click Finish.

17. After Drive Image has completed the copying process, click OK  to return to the Drive 
Image main screen and exit the program.

Result

The computer reboots and returns to Windows 95. Because only one primary partition 
may be visible at a time, the new partition does not appear in Windows Explorer.

If you ever wish to replace the active partition with the hidden backup partition (for 
instance, if you lose data from your C: partition), run Drive Image Disk To Disk again. 
Select the hidden partition as the source and the active partition as the destination. After 
Drive Image completes the copying process, it prompts you to set an active partition. 
Select the newly copied partition.
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Scenarios

Copying from Drive to Drive in a Dual Hard Drive System

Sample System Configuration

Disk 1 — One 3 GB hard drive containing:

• One active primary partition (C:) running Windows 95; 500 MB used and 1 GB unused.

• One extended partition containing one logical partition (E:); 400 MB used and 600 MB 
unused.

• 500 MB unpartitioned free space.

Disk 2 — One 2 GB hard drive containing:

• One primary partition (D:); 400 MB used and 600 MB unused.

• One extended partition containing one logical partition (F:); 200 MB used and 800 MB 
unused.

Objective

Copy the E: partition from Disk 1 to the F: partition on Disk 2.

Procedure

1. Run Drive Image.

2. From the Drive Image title screen, click Disk To Disk.

3. Select Disk 1.

4. Click Next.

5. Select the E: partition.

6. Click Next.

7. Select Disk 2.

8. Click Next.

9. Select the F: partition.
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10. Click Next.

The following message appears: 

“Destination selected is not free space. Partitions can only be copied into existing free 
space. Drive Image will delete this partition before copying. WARNING: Deleting a 
partition will DESTROY any existing data on that partition.”

Click OK .

11. From the Ready To Copy Disk To Disk screen, click Advanced Options.

12. Under the Source Options, unmark the Check for File System Errors box.

13. Click OK .

14. Click Finish.

15. After Drive Image has completed the copying process, click OK  to return to the Drive 
Image main screen and exit the program.

Result

The computer reboots and returns to Windows 95. Drive letters stay the same, but the F: 
partition now contains the same data as the E: partition.
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Chapter

Drive Image File Editor

This chapter contains the following information:

• Drive Image File Editor -- Main Screen

• Opening Image Files

• Deleting Image Files

• Creating New Image Files

• Copying Image Files

• Working with Image File Passwords

• Accessing Partition Properties

• Copying Partitions

• Deleting Partitions

• Compressing Partitions

• Uncompressing Partitions

• Restoring Individual Files from a Partition

• Speeding up the Restore Process

PowerQuest’s Drive Image File Editor simplifies management of your image files. 
Working within a single screen, Drive Image File Editor gives you total image file control, 
allowing you to create and copy image files, copy or delete partitions within files, 
compress and uncompress partitions, and restore individual program and data files from 
imaged partitions. Drive Image File Editor also provides name and comment capabilities, 
for easy identification of individual files and partitions.

6
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Drive Image File Editor—Main Screen
Drive Image File Editor’s main screen is divided into three sections: Recent Images, 
Image File Information, and Partitions (see Fig. 6.1).

Fig. 6.1 – Image File Editor Main Screen

Recent Images 
Recent Images lists the PowerQuest image files most recently accessed. Click any 
filename in this list to view the corresponding image file and partition information. You 
can also right-click anywhere in the Recent Images list box to access a quick menu of all 
the commands in the Image menu.

The Recent Images list holds up to 16 file names. Additional file names bump the oldest 
items from the list. To clear this list, select Image>Recent Images>Clear List from the 
menu bar. To remove a single list entry, select Image>Recent Images>Remove Entry.

Image File Information
Image File Information displays user-assigned Name and Comment information for the 
selected image file. You may specify a name by typing directly in the Name field, or by 
selecting Image>Name from the menu bar. If no name is assigned, this field remains blank. 
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Drive Image File Editor—Main Screen

You may also specify a comment by typing directly in the Comment field, or by selecting 
Image>Comment from the menu bar. If no comment is assigned, this field remains blank.

Partitions

Partitions displays the partitions in the selected image file. The following information is 
provided for each partition:

• Name identifies a user-assigned name for the selected partition. You may specify a 
name by selecting Partition>Name from the menu bar. If no name is assigned, this 
field remains blank.

• Drive Letter identifies the drive letter associated with the selected partition.

• Type specifies the file system type (e.g. FAT, NTFS, HPFS, etc.) of the selected 
partition.

• Status identifies the selected partition’s drive status as either Primary or Logical.

• Date identifies the date the selected partition’s image file was created.

• Size specifies the selected partition’s file size.

• Compressed identifies whether the selected partition is compressed or uncompressed. 
If the partition is compressed, the level of compression (Low or High) is also specified.

NOTE: Low level compression yields an approximate 40% compression rate. 
High level compression is approximately 50%.

Opening Image Files

To open a new image file, perform the following:

1. From the menu bar, select Image>Open or click the Open Image File icon.

The Open dialog appears.

NOTE: You may also right-click inside the Recent Images list box and select Open 
from the quick menu.

2. Navigate to the folder where the image file is located.

3. Select the desired image file.

NOTE: Drive Image File Editor can only open files created with Drive Image, Drive 
Image Professional, or Drive Image File Editor.

4. Click Open.

The filename appears in the Recent Images list.
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Deleting Image Files

To delete an image file, perform the following:

1. From the menu bar, select Image>Open or click the Open Image File icon.

The Open dialog appears.

2. Navigate to the folder where the image file is located.

3. Select the desired image file.

4. Press <DEL>.

The following message appears: “Are you sure you want to send [*.PQI] to the 
Recycle Bin?”

5. Click Yes.

The image file is deleted.

6. Click Cancel to exit the Open dialog.

Or, you may follow these steps:

1. From the menu bar, select Image>New or click the Create New Image icon.

The New Image File dialog appears.

2. Navigate to the folder where the image file is located.

3. Select the desired image file.

4. Press <DEL>.

The following message appears: “Are you sure you want to send [*.PQI] to the 
Recycle Bin?”

5. Click Yes.

The image file is deleted.

6. Click Cancel to exit the New Image File dialog.

NOTE: Image files may also be deleted using Microsoft’s Windows Explorer utility. 
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Creating New Image Files

Drive Image File Editor allows you to create empty image files, which may then be 
customized by copying desired partitions from other files. To create a new image file, 
perform the following:

1. From the menu bar, select Image>New or click the Create New Image icon.

The Save As dialog appears.

NOTE: You may also right-click inside the Recent Images list box and select New 
from the quick menu.

2. Navigate to the folder where you wish to create the image file.

3. Specify a new image filename.

4. Click Save.

The new filename appears in the Recent Images list. 

Creating Spanned Image Files

Drive Image File Editor allows you to save an existing image file across a series of disks 
(e.g. floppy disks and removable media storage devices such as Jaz, Zip, and SyQuest 
disks) in a spanned format. To span an existing image file, perform the following:

1. In the Recent Images list, select the file you wish to span.

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

2. From the menu bar, select Image>Span.

The Create Spanned Image dialog appears.

NOTE: You may also right-click the selected image file in the Recent Images list 
box and select Span from the quick menu.

3. Navigate to the location where you wish to save the spanned image.

NOTE: You must have at least 100 KB free on the destination drive.
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4. Specify the spanned image filename.

5. Click Save.

Drive Image File Editor creates the spanned image file, prompting you for each new 
diskette. Drive Image permits you to span a maximum of 50 disks with a limit of 12 
partitions per image file. You must have at least 100K of available space on each disk in 
the series. If you use the media-spanning feature, be sure to number the disks in order, 
since you must insert them in sequence when restoring the image file. 

Combining Spanned Images Files

Drive Image File Editor allows you to recombine a spanned image file into a single, 
unified file. To combine a spanned image file, perform the following:

1. In the Recent Images list, select the file you wish to combine.

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

2. From the menu bar, select Image>Combine.

The Combine Spanned Image dialog appears.

NOTE: You may also right-click the selected image file and select Combine from 
the quick menu.

3. Navigate to the location where you wish to save the combined image.

4. Specify the combined image filename.

5. Click Save.

The image file is combined and saved under the specified filename.

Copying Image Files

Although image files cannot be directly copied within Drive Image File Editor, file copies 
may be made in one of two ways. To copy an image file, perform the following:
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1. In the Recent Images list, select the file you wish to copy.

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

The file’s partition information appears in the Partitions group box.

2. Shift-click to select contiguous partitions or Control-click to select discontiguous 
partitions.

3. From the menu bar, select Partition>Copy or click the Copy Partition icon.

The Copy to Image File dialog appears.

4. Navigate to the folder where you wish to create the image file.

5. Specify a new image filename.

6. Click Save.

The following message appears: “Copy partitions to image file [*.PQI]?”

7. Click Yes.

The copied partitions appear in the newly-created image file.

Or, you may follow these steps:

1. From the menu bar, select Image>New or click the Create New Image icon.

The Save As dialog appears.

2. Navigate to the folder where you wish to create the image file.

3. Specify a new image filename.

4. Click Save.

The new filename appears in the Recent Images list.

5. In the Recent Images list, select the file you wish to copy.

The file’s partition information appears in the Partitions group box.

6. Shift-click to select contiguous partitions or Ctrl-click to select discontiguous 
partitions. 
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7. Drag-and-drop the partitions to the newly-created filename in the Recent Images list. 
The following message appears: “Copy partitions to image file [*.PQI]?”

8. Click Yes.

The copied partitions appear in the newly-created image file.

NOTE: Image files may also be copied using Microsoft’s Windows Explorer utility.

Working with Image File Passwords

When you create an image file in Drive Image, you have the option to assign a password 
to that file. Once assigned, the password is encrypted into the file and cannot be changed. 
Password-protection is an excellent means of securing your image files; however, editing 
protected files can be confusing. Following are some general rules for working with 
password-protected files:

Images

If you wish to undo or reassign a password, you must use Drive Image to restore the 
protected image file and then create a new image file with a different password.

Partitions

Partitions from a password-protected image file retain that password. Such partitions 
cannot be copied or saved into an image file with a different password, nor can partitions 
with different passwords be combined to create an new image file.

Accessing Partition Properties

To access a partition’s properties information, perform the following:

1. In the Recent Images list, click the file that contains the desired partition. 

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

2. In the Partitions group box, select the desired partition.
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Accessing Partition Properties

3. From the menu bar, select Partition>Properties.

NOTE: You may also right-click the partition and select Properties from the quick 
menu.

The Properties dialog appears.

4. To exit the Properties dialog, click OK .

Properties Information

Displays the properties of the selected partition. The following information is provided on 
each partition:

• Name identifies a user-assigned name for the partition.

• Comment specifies a user-assigned comment associated with the partition.

• Drive Letter  identifies the partition drive letter.

• Partition Type specifies the file system type of the partition.

• File System Type specifies the file system type of the image file in which the partition 
is located.

• Status identifies the selected partition’s drive status as either Primary or Logical.

• Spanned identifies whether the partition is spanned over several disks.

• Compression identifies whether the selected partition is compressed or uncompressed. 
The level of compression (Low or High) is also specified. 

NOTE: Low level compression yields an approximate 40% compression rate. 
High level compression is approximately 50%.

• Password Protected identifies whether the selected partition is password protected.

• Partition Size specifies the total size of the partition. This total includes both used and 
free space.

• Used Space in Partition specifies the amount of used space within the partition.

• Free Space in Partition specifies the amount of free or unused space within the 
partition.

• Physical Size in Image identifies the actual size of the partition within the image file. 
This physical size may differ from the Partition Size depending upon the amount of 
used and free space within the partition and the compression level.
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Copying Partitions

You may copy single or multiple partitions between image files. Copied partitions will not 
overwrite any partition already in the file. Therefore, you may have several partitions with 
the same name, drive letter, etc. within one image file.

To copy a partition, perform the following:

1. In the Recent Images list, select the file that contains the partition(s) you wish 
to copy. 

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

2. In the Partitions group box, select the desired partition(s).

3. Drag-and-drop the partition(s) to the desired file in the Recent Images list.

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

The following message appears: “Copy partition(s) to image file [*.PQI]?”

4. Click Yes.

The copied partitions appear in the image file.

Or, you may follow these steps:

1. In the Recent Images list, select the file that contains the partition(s) you wish 
to copy. 

2. In the Partitions group box, select the desired partition(s).

3. From the menu bar, select Partition>Copy or click the Copy Partition icon.

NOTE: You may also right-click the partition(s) and select Copy from the quick menu.

The Copy to Image File dialog appears.

4. Navigate to the location of the image file to which you want to copy the partition(s).

5. Select the desired image file.
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6. Click Save.

The following message appears: “Copy partition(s) to image file [*.PQI]?”

7. Click Yes.

The copied partition(s) appear in the image file.

Deleting Partitions

To delete single or multiple partitions, perform the following:

1. In the Recent Images list, click the file that contains the partition(s) you wish 
to delete. 

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

2. In the Partitions group box, select the desired partition(s).

3. From the menu bar, select Partition>Delete or click the Delete Partition icon.

NOTE: You may also right-click the partition(s) and select Delete from the quick menu.

The following message appears: “Delete partition? or Delete all selected partitions?”

4. Click Yes.

The partition(s) are deleted from the image file.

Compressing Partitions

Drive Image File Editor allows you to compress individual partitions and save them to 
another image file. Compressed partitions will not overwrite any partition already in the 
file. Therefore, you may have several partitions with the same name, drive letter, etc. 
within one image file.
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To compress a partition, perform the following:

1. In the Recent Images list, select the file that contains the partition you wish to 
compress. 

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

2. In the Partitions group box, select the desired partition.

3. From the menu bar, select Partition>Compress.

NOTE: You may also right-click the partition and select Compress from the 
quick menu.

The Compress to Image File dialog appears.

4. Navigate to the location of the image file in which you want to save the compressed 
partition.

5. Select the desired image file.

6. Click Save.

The Compress Partition dialog appears.

7. Select the compression level, either Low or High.

NOTE: Selecting Low compresses partitions by approximately 40%. High 
increases the compression ratio to approximately 50%.

8. Click Compress.

The compressed partition appears in the image file.

Uncompressing Partitions

Drive Image File Editor allows you to uncompress individual partitions and save them to 
another image file. Uncompressed partitions will not overwrite any partition already in the 
file. Therefore, you may have several partitions with the same name, drive letter, etc. 
within one image file.
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To uncompress a partition, perform the following:

1. In the Recent Images list, select the file that contains the partition you wish to 
uncompress. 

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

2. In the Partitions group box, select the desired partition.

3. From the menu bar, select Partition>Uncompress.

NOTE: You may also right-click the partition and select Uncompress from the 
quick menu.

The Uncompress to Image File dialog appears.

4. Navigate to the location of the image file in which you want to save the uncompressed 
partition.

5. Select the desired image file.

6. Click Save.

The following message appears: “Uncompress partition to image file [*.PQI]?”

7. Click Yes.

The uncompressed partition appears in the image file.

Restoring Individual Files from a Partition

Drive Image File Editor allows you to restore (extract) individual program and data files 
from imaged partitions and save them to any directory or folder. You can restore single 
files or you can restore multiple files at the same time.

To restore (extract) one or more files, perform the following:

1. In the Recent Images list, select the image file that contains the partition with the 
file(s) you wish to restore. 

NOTE: If the image file is not listed, you must first open it. See “Opening Image 
Files” (page 63) for more information.
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2. In the Partitions group box, select the desired partition.

3. From the menu bar, select Partition>File Restore.

NOTE: You may also right-click the partition and select File Restore from the quick 
menu.

The File Restore dialog appears.

4. Select the file you wish to restore.

Shift-click to select contiguous files or Ctrl-click to select discontiguous files.

Double-click on a folder to browse its contents for the desired file(s). To return to the 
previous directory level, click the folder button to the right of the Look In  field, or 
backtrack using the list in the Look In  field.

The name of the selected file appears in the File name field. If multiple files are 
selected, (multiple files) appears in the File name field.

You can also type the filename directly into the File name field or use wildcard 
characters such as “*” and “?” to reduce the number of files listed.

5. In the Target Directory  field, enter the location where you want to save the restored 
file(s).

You may also click Browse to browse the directory tree for the desired target folder. 
Double-click on the target folder, then click Select.

6. Click Restore to restore the file(s).

NOTE: If you assigned a password to your image file when you created it, Drive 
Image prompts you for a password. Enter the password you assigned to 
the image file, then click OK  to continue.

Drive Image File Editor displays the following information:

• “Restoring File: <filename>”

• “To Directory: <directory name>”

• Progress indicator bar

7. When Drive Image File Editor completes restoring the file(s), click OK .

8. Click Close to return to the Drive Image File Editor main window.
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Speeding Up the Restore Process

When restoring image files, compressed partitions can slow down the process. The 
program must spend time uncompressing each partition. This process becomes much 
faster if you perform the uncompressing yourself. 

To speed up the restore process, perform the following:

1. In Drive Image File Editor, select the image file you wish to restore from the Recent 
Images list.

NOTE: If the file is not listed, you must first open the file. See “Opening Image 
Files” (page 63) for more information.

2. Uncompress all partitions within the image file.

NOTE: See “Uncompressing Partitions” (page 72) for more information.

NOTE: Uncompressed partitions do not overwrite their compressed counterparts. 
When you use Drive Image to restore the image file, be careful to select only 
one version of the partitions (compressed or uncompressed). If you click 
Select All to select all partitions in the image file, Drive Image will restore 
both compressed and uncompressed versions to the destination drive. You 
can avoid this by creating a new image file for the uncompressed partitions, 
or by deleting each compressed partition after it has been uncompressed.

3. Using Drive Image, restore the image file to the destination drive.

4. If space is limited, you can use Drive Image File Editor to re-compress the image file 
partitions after the image file is restored. 

NOTE: Note: See “Compressing Partitions” (page 71) for more information.

The image file is restored to the destination drive with the desired partition compression.
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Chapter

Additional Utilities

This section contains the following information:

• Drive Mapper

• Magic Mover

To simplify partition management, PowerQuest has included DriveMapper and 
MagicMover with Drive Image.

DriveMapper

DriveMapper is a wizard for Windows 3.x, Windows 95, and Windows NT that allows 
you to easily alter drive letter assignments for partitions and your CD-ROM drive. 
Because some files, such as .INI, configuration, and preferences fields, may keep 
references to the old drive letters, your system may not function properly when drive 
letters have changed. You can use DriveMapper to search for these references and change 
them to the new drive letter assignments.

DriveMapper corrects one drive letter at a time. If you have only one drive letter change 
(such as your CD-ROM drive), you need to change only one reference. If more than one 
letter has changed, you will have to change the drive letters one at a time in the correct order.

NOTE: If you are using Windows NT as your only operating system, we recommend 
that you use Disk Administrator rather than DriveMapper. Disk 
Administrator allows you to set the drive letters for your partitions so that 
adding and removing partitions will not cause any drive letters to change.

7
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NOTE: If you have installed an alternative desktop on Windows 3.11 or 
Windows 95 with the files residing on a different drive than the Windows 
system files, DriveMapper may not be able to adjust your paths. 
DriveMapper is a Windows program and must have Windows loaded in 
order to run. If the drive letter has been changed for the drive that holds your 
desktop files, you may not be able to bring up Windows.

NOTE: For information on making the operating system assign a drive letter to your 
CD-ROM, see “Making the Operating System Assign a CD-ROM Drive 
Letter” in Appendix A.

Avoid Using DriveMapper With Multiple Operating Systems

If you run multiple operating systems on your computer, using DriveMapper is not 
recommended. Instead, you should reinstall applications. The following issues make using 
DriveMapper in a multiple operating system environment difficult and error-prone:

• Drive letter assignments depend on which file systems an operating system supports. If 
you do not put all FAT32, NTFS, and HPFS partitions after all FAT partitions, drive 
letters change depending on the operating system that is running, and DriveMapper 
may be unable to correctly identify which changes should be made.

• Registry settings are changed for the current operating system only. If you rerun 
DriveMapper from another operating system, references in files are already changed 
and further changes introduce errors.

• DriveMapper does not update registry files contained in hidden partitions. If you are 
using multiple primary partitions for different operating systems, only the active 
primary partition may be visible. Thus, only files in that primary partition are updated.

NOTE: While you can rerun DriveMapper multiple times and use the /SSD (Select 
Search Drives) switch when starting DriveMapper (to allow you to specify 
which drives to search), doing so requires careful attention to detail, and errors 
are probable.

• While DriveMapper can update most OS/2 references, it does not change OS/2 
Extended Attributes.
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Change Drive Letters in the Correct Order

You must change drive letters in the correct order to avoid destroying original references 
before they are used to make the appropriate changes for other drive letters. For example, 
assume that you have two partitions on your hard drive assigned the drive letters C: and D: 
and a CD-ROM drive assigned E:. If you create a logical partition between C: and D:, the 
drive letter of D: would change to E:, and the drive letter of E: would change to F:. 
However, references in certain files would continue to reflect the old drive letter 
assignments. You can use DriveMapper to first change the drive E: references to F: and 
then the drive D: references to E:.

WARNING: When you make a change to your hard drive that adds drive letters, always 
change the highest affected drive letter first. If you change them in a 
different order, you will change source references needed to change other 
drive mappings.

You can also make changes to your hard drive that will decrease the number of drive 
letters. To illustrate a case in which you would decrease the number of drive letters, 
assume that you have four partitions on your hard drive: C:, D:, E:, and F:. If you delete 
D:, E: would change to D:, and F: would change to E:. Starting with the lowest affected 
drive letter, use DriveMapper to reassign the current drive letter in files that contain 
incorrect references.

WARNING: When you make a change to your hard drive that decreases the number of 
drive letters, always change the lowest affected drive letter first. If you 
change them in a different order, you will change source references needed 
to change other drive mappings.

Changing References for One Drive Letter

NOTE: For information on making the operating system assign a drive letter to your 
CD-ROM, see “Making the Operating System Assign a CD-ROM Drive 
Letter” in Appendix A.

To change references for one drive letter, perform the following:

1. From Windows 3.x, launch DriveMapper by double-clicking the DriveMapper icon in 
the Drive Image by PowerQuest program group.

OR

From Windows 95 or NT, click Start>Programs>Drive Image by 
PowerQuest>DriveMapper.
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2. Click Next to go to the Drive Letter Changes screen.

3. Select Only one drive letter changed and click Next.

4. Type the old drive letter in the first field.

5. Type the new drive letter in the second field and click Next.

DriveMapper searches for references to the old drive letter. This may take several 
minutes. A progress window displays the percentage of the search completed.

6. When the Search Results screen appears, click Next to change all references.

OR

Select View changes to be made and click Next to select which references should be 
changed.

7. When you have changed your drive references, click Finish.

Changing References for More Than One Drive Letter

NOTE: For information on making the operating system assign a drive letter to your 
CD-ROM, see “Making the Operating System Assign a CD-ROM Drive 
Letter” in Appendix A.

To change references for more than one drive letter, perform the following:

1. From Windows 3.x, launch DriveMapper by double-clicking the DriveMapper icon in 
the Drive Image by PowerQuest program group.

OR

From Windows 95 or NT, click Start>Programs>Drive Image by 
PowerQuest>DriveMapper.

2. Click Next to go to the Drive Letter Changes screen.

3. Select More than one drive letter changed and click Next.

4. Type the old drive letter in the first field.
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5. Type the new drive letter in the second field and click Next.

DriveMapper searches for references to the old drive letter. This may take several 
minutes. A progress window displays the percentage of the task completed.

6. When the Search Results screen appears, click Next to change all references.

OR

Select View Changes To Be Made and click Next to select which references should 
be changed.

7. When you have changed the references for the first drive, click Restart to change 
references for another drive letter and repeat steps 1–6.

8. When finished changing your drive references, click Finish.

MagicMover

MagicMover helps you move applications from one partition to another. For example, you 
can use Drive Image to restore partitions to a new drive and then you can use MagicMover 
to move applications from one partition to another along with all their related files and 
operating system settings.

PowerQuest has included two versions of MagicMover: 

• A 32-bit version for Windows 95 and Windows NT 4.0 

• A 16-bit version for Windows 3.x

32-Bit Version

This section explains how to install and use the 32-bit version of MagicMover. If you are 
running Windows 3.x, you should refer to the “16-Bit Version” section (page 84).

Installing MagicMover

To install the 32-bit version of MagicMover from Windows 95 or Windows NT 4.0, 
perform the following:

1. Insert the Drive Image CD-ROM into your CD-ROM drive.

2. Click Start>Run.
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3. Launch the installation program by typing drive:\SETUP32.EXE in the Run dialog 
box, where drive is the drive letter of the CD-ROM drive, and pressing <ENTER>.

4. In the Installation Options dialog, select Install PowerQuest MagicMover.

5. Follow the on-screen instructions.

NOTE: By default, MagicMover icons are installed under Start>Programs> 
PowerQuest MagicMover. However, during the installation, you can 
choose to install MagicMover in a different location.

Moving Applications

Moving applications involves three simple steps:

1. Select the application to move.

2. Select the destination location (i.e. the drive and directory where you want to move 
the application).

3. Review the operation summary (optional).

These three steps are shown on the right side of MagicMover's main window. A red 
arrow displays next to the step you are currently performing. When you complete that 
step, the red arrow moves to the next step and a green check displays next to the 
completed step.

To move an application using the 32-bit version of MagicMover, perform the following:

1. Launch MagicMover (if you installed to the default location, click 
Start>Programs>PowerQuest MagicMover).

Because your system changes any time you install or delete files and applications, 
MagicMover now performs a scan to obtain the most current information about your 
system. The scan locates all files on your system and determines their sizes, dates, and 
interdependencies, such as which executables use which DLLs and their variants 
(OCX, VBX, etc.).

When the scan is complete, MagicMover's main window appears. 

Displayed on the right side of this window are the three steps to move an application. 
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On the left side of the window is an icon representing the applications on the desktop, 
an icon representing applications in the Start menu, and icons representing the drives 
that MagicMover found when it scanned your system. 

NOTE: You can cancel the operation at any time by clicking Cancel, or you can go 
back to the previous step by clicking Back.

2. Double-click the appropriate icon.

3. Double-click the desired destination folder or root directory.

4. Select the program you wish to move by clicking its icon.

NOTE: You can select an individual application or a complete program group. 

When you select an icon, the complete file path for the represented application displays.

5. When you have selected the application you want to move, click Next.

MagicMover makes sure that it is safe to move the applications and files you have 
selected. A status bar appears displaying the progress of the analysis. If MagicMover 
cannot move the application, a dialog appears notifying you that the program or folder 
cannot be moved.

NOTE: MagicMover cannot move any application from the Windows directory or 
any of its subdirectories.

The three steps to move an application are shown in this dialog box. Step One now 
has a green check beside it, indicating that it is complete. 

The first field in this dialog shows the complete path where the application you want 
to move is currently installed. The dialog also shows the approximate combined size 
of the files being moved.

NOTE: To view a complete list of all of the files being moved and changes that will 
be made to the Registry and .INI files, click Details.

6. In the Select The Destination Folder field, specify where you want to move the 
application.

Type the full path.
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OR

Click Browse to select a destination from the directory tree. Double-click directories 
to open them. Click OK when you have selected the desired directory.

7. When you have selected the directory to which you wish to move the application, 
click Move.

A progress bar appears. MagicMover moves the necessary files to the selected drive 
and directory, updates the links between the application's files, updates the 
appropriate Windows Registry entries and .INI files, and scans the links.

When the move is complete, a dialog box appears showing you which applications 
were moved (in icon form), the drive and directory to which they were moved, and the 
actual size of files moved. You can also review the actions that MagicMover took 
during the operation by clicking Details.

8. When you are finished moving applications, click Close to exit MagicMover. 

9. Reboot the computer.

16-Bit Version

This section explains how to install and use the 16-bit version of MagicMover. If you are 
running Windows 95 or Windows NT, you should refer to the “32-Bit Version” section 
(page 81).

Installing MagicMover

To install the 16-bit version of MagicMover from Windows 3.x, perform the following:

1. Insert the Drive Image CD-ROM into your CD-ROM drive.

2. Select Run from the Program Manager File menu.

3. Launch the installation program by typing drive:\SETUP16.EXE, where drive is the 
drive letter of the CD-ROM drive, and pressing <ENTER>.

4. In the Installation Options dialog, select Install PowerQuest MagicMover.

5. Follow the on-screen instructions.
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The installation program creates a new program group with the appropriate icons.

NOTE: By default, MagicMover is installed to drive:\POWERQUEST 
MAGICMOVER; however, during installation you can specify another 
location.

Moving Applications

Moving applications involves three simple steps:

1. Select the application to move.

2. Select the destination location (the drive and directory where you want to move the 
application).

3. Review the operation summary (optional).

These three steps are shown on the right side of MagicMover's main window. A red 
arrow displays next to the step you are currently performing. When you complete that 
step, the red arrow moves to the next step and a green check displays next to the 
completed step.

To move an application using the 16-bit version of MagicMover, perform the following:

1. Launch MagicMover (if you installed to the default location, double-click the 
PowerQuest MagicMover icon in the PowerQuest MagicMover program group).       

Because your system changes any time you install or delete files and applications, 
MagicMover now performs a scan to obtain the most current information about your 
system. The scan locates all files on your system, determining their sizes, dates, and 
interdependencies, such as which executables use which DLLs and their variants 
(OCX, VBX, etc.).

When the scan is complete, MagicMover's main window appears.

Displayed on the right side of this window are the three steps to move an application. 

On the left side of the window is an icon representing the applications on your system 
and icons representing the drives that MagicMover found when it scanned your system.

NOTE: You can cancel the operation at any time by clicking Cancel, or you can go 
back to the previous step by clicking Back.
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2. Double-click the appropriate icon.

3. Double-click the desired folder.

4. Select the program you wish to move by clicking its icon.

When you select an icon, the complete file path for the represented application 
displays.

5. When you have selected the application you want to move, click Next.

MagicMover makes sure that it is safe to move the applications and files you have 
selected. A status bar appears displaying the progress of the analysis. If MagicMover 
cannot move the application, a dialog appears notifying you that the program or folder 
cannot be moved.

NOTE: MagicMover cannot move any application from the Windows directory or 
any of its subdirectories.

The three steps to move an application are shown in this dialog box. Step one now has 
a green check beside it, indicating that it is complete. 

The first field in this dialog shows the complete path where the application you want 
to move is currently installed. The dialog also shows the approximate combined size 
of the files being moved.

NOTE: To view a complete list of all of the files being moved and changes that will 
be made to the Registry and .INI files, click Details.

6. In the Destination field, specify where you want to move the application.

Type the full path.

OR

Click Browse to select a destination from the directory tree. Double-click directories 
to open them. Click OK when you have selected the desired directory.



87

MagicMover

7. When you have selected the files you want to move and the destination directory 
where you want to move the files, click Move.

A progress bar appears. MagicMover moves the necessary files to the selected drive 
and directory, updates the links between the application's files, updates the 
appropriate Windows Registry entries and .INI files, and scans the links.

When the move is complete, a dialog box appears showing you which applications 
were moved (in icon form), the drive and directory to which they were moved, and the 
actual size of files moved. You can also review the actions that MagicMover took 
during the operation by clicking Details.

8. When you are finished moving applications, click Close to exit MagicMover.

9. Reboot the computer.
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Appendix

Additional Resource Information

This appendix contains the following information: 

• Hard Drive Manufacturer Contact Information

• Benefits of Using PartitionMagic

• Using FDISK and FORMAT to Create and Format Partitions

• Using Drive Image with SCSI Hard Drives

• Using Drive Image with Older Computer BIOSes that require Drive Overlay Software 

• Making the Operating System Assign a CD-ROM Drive Letter

Hard Drive Manufacturer Contact Information

To find the jumper settings for hard drives, consult your hard drive installation guide or 
contact your hard drive manufacturer directly. This section contains the World Wide Web 
site addresses and phone numbers for the most common hard drive manufacturers. In most 
cases, the hard drive manufacturer's web site will contain the information you need to 
install the hard drive correctly.

Another valuable resource is the web page, http://blue-planet.com/tech/index.html. In 
addition to listing the most common hard drive manufacturers, this site provides the 
jumper settings for every hard drive ever made.

Additional jumper information is available from OnTrack at http://www.ontrack.com.

A
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Contact Information

NOTE: The following contact information was correct at the time this manual was 
printed. Information is subject to change.

Fujitsu 
• URL: http://www.fcpa.com/support/su_support_frame.html

• Tech Support Phone: 800-626-4686

• Fax Back Support: 408-428-0456

Maxtor
• URL: http://www.maxtor.com/ide_cmos.html

• Tech Support Phone: 800-2-Maxtor or 800-262-9867

• Tech Support Fax: 303-260-2260 or 408-922-2050

• E-mail: Technical Assistance@Maxtor.com

Quantum
• URL: http://support.quantum.com/

• Tech Support Phone: 800-826-8022

• Fax Back Support: 800-434-7532

Samsung Electronics America
• URL: http://www.sec.samsung.co.kr/support/faqs/index.html

• Tech Support Phone: 800-726-7864

• Fax Back Support: 800-229-2239
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Benefits of Using PartitionMagic

Seagate/Conner
• URL: http://www.seagate.com/support/disc/specs/qickspec.shtml

• Tech Support Phone: 408-456-4496 

• Tech Support Fax: 405-936-1685

• Fax Back Support: 405-936-1600

• Automated Support: 800-732-4283

Western Digital
• URL: http://www.wdc.com/support/welcome2.html

• Tech Support Phone: 800-275-4932

• Fax Back Support: 714-932-4300

Benefits of Using PartitionMagic

In addition to Drive Image and DriveCopy, PowerQuest Corporation makes PartitionMagic. 
PartitionMagic 3.0 is the revolutionary utility that lets you reclaim wasted disk space, safely 
boot and run multiple operating systems and organize and protect your data.

Reclaim Wasted Disk Space

Everyone wants to get the most they can out of their hard drive. But, up to 40% of your 
hard drive may be totally wasted due to inefficient storage methods. PartitionMagic 3.0 
increases your usable disk space by shrinking large FAT partitions and restructuring 
cluster sizes to reclaim up to hundreds of megabytes of lost disk space.

Safely Run Multiple Operating Systems

PartitionMagic 3.0 makes it easy to run multiple operating systems on the same machine 
without compatibility problems. Explore the world of Windows 95 or NT while still 
relying on the security of your current operating system. And PartitionMagic 3.0 includes 
Boot Manager from IBM, making it easy to select an operating system every time you 
boot your computer.
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Organize and Protect Data

Create a physically separate partition for your valuable data files to protect them from 
potentially unstable applications and operating systems. This simplifies backups, 
especially to devices like Zip drives. PartitionMagic also includes a utility that lets you 
easily move applications from one partition to another with their files and operating 
system settings in place. With PartitionMagic it’s easy to create, resize and move hard 
drive partitions on the fly.

Additional Benefits

Once you organize, optimize, and secure your hard drive, you can take advantage of 
PartitionMagic's other useful features. For instance, you can view comprehensive 
information about your hard-disk geometry and your hardware system. You can also 
resize root directories in Windows 95 to make room for more long file names. With 
PartitionMagic, configuring your hard drive has never been simpler.

Order Information

To purchase PartitionMagic, visit your local computer software store or call 
(800) 379-2566. You can also order PartitionMagic from our web site at 
http://www.powerquest.com. All credit card transactions are secure.
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Using FDISK and FORMAT to Create and Format Partitions

NOTE: Although FDISK and FORMAT do not offer the functionality and flexibility 
of PartitionMagic, these free utilities are capable of creating new FAT 
partitions or deleting existing partitions.

This section explains how to create and delete partitions for the following situations:

Scenario 1:

If you copied a single FAT partition (C: drive) from your source hard drive to a 
destination hard drive larger than 2.1 GB, you now have unallocated disk space and need 
to create a partition(s). To create and format a partition(s) using FDISK and FORMAT, 
follow these simple steps:

NOTE: Using FDISK to create partitions from unallocated disk space is simple and 
will NOT destroy any existing data on the hard drive. FDISK, however, will 
NOT allow you to change partition sizes without destroying data.

1. At a DOS or MS-DOS prompt, type FDISK  and press <ENTER>.

2. Select 1 to Create DOS partition or Logical DOS Drive and press <ENTER>.

3. Select 2 to Create Extended DOS partition and press <ENTER>.

4. Press <ENTER> again to create the Extended DOS partition.

5. Press <ESC>.

6. Press <ENTER> to create the Logical DOS Drive within the Extended partition.

7. If your hard drive is larger than 4 GB, you can create a second Logical DOS partition 
with the remaining disk space. To do so press <ENTER>.

8. Press <ESC> twice to return to a DOS or MS-DOS prompt.

To format your new partition(s) type FORMAT drive: at a DOS or MS-DOS prompt 
where drive: is the drive letter of the new partition. You will now have additional 
partitions on your destination hard drive (example D:, E:).
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Scenario 2:

If you want to leave your source drive in as a secondary or Slave drive after the copy, you 
need to delete and recreate partitions so that drive letters will not conflict. To delete and 
recreate partitions on your source hard drive after the copy process is finished follow 
these steps:

NOTE: This process will delete the data on this hard drive; however, you have a 
complete copy on your destination drive.

1. If you have not already done so, change the jumper settings on the original source 
drive to reflect a secondary or Slave setting in a two drive system. Then switch the 
jumper settings on the destination drive to reflect a primary or Master setting in a two 
drive system.

2. At a DOS or MS-DOS prompt type, FDISK  and press <ENTER>.

NOTE: If you are asked whether you wish to enable large disk support, click YES 
and press <ENTER> UNLESS you plan on using other operating systems on 
your PC, including some versions of Windows 95 and Windows NT, as well 
as earlier versions of Windows and MS-DOS.

3. Select 5 to Change Current Fixed Disk Drive and press <ENTER>.

4. At the Change Current Disk Drive Screen, choose 2 to change to your second disk 
drive and press <ENTER>.

5. Next select 3 to Delete partition or Logical DOS drive and press <ENTER>.

6. Choose to delete your logical drive(s) first and then your extended partition and then 
finally your primary partition(s). Or if you only have one partition on your source 
hard drive choose to delete the single primary partition.

7. Select 1 to Create DOS partition or Logical DOS Drive and press <ENTER>.

8. Next select 2 to Create Extended DOS partition and press <ENTER>.

9. Press <ENTER> again to create the Extended DOS partition.

10. Press <ESC>. 

11. Press <ENTER> to create the Logical DOS Drive within the Extended partition.



95

Using Drive Image with SCSI Hard Drives

12. If your hard drive is larger than 4 GB, you can create a second Logical DOS partition 
with the remaining disk space. To do so press <ENTER>.

13. Press the <ESC> key twice to return to a DOS or MS-DOS prompt.

14. To format your new partition(s) type FORMAT drive: at a DOS or MS-DOS prompt 
where drive is the drive letter of the new partition.

You now have a new empty partition(s) in which to store your applications and data.

Using Drive Image with SCSI Hard Drives

To use Drive Image on a SCSI hard drive, you must have a SCSI controller card that 
supports software Interrupt 13. Most SCSI controller cards let the user enable software 
Interrupt 13 support in the BIOS through the card. If your SCSI controller card does not 
allow you to set it to use software Interrupt 13, Drive Image will not work on drives 
attached to your SCSI adapter. Contact the manufacturer of the SCSI adapter to determine 
if your adapter can support software Interrupt 13. As a general rule, if FDISK can be used 
to partition the drive, you can use Drive Image.

Using Drive Image with Older Computer BIOSes that 
Require Drive Overlay Software

Drive overlay software is needed, such as Disk Manager or EZ-Drive, if the system has an 
older BIOS and the disk copy is being made from IDE to IDE or IDE to SCSI. 

NOTE: If copying SCSI to SCSI, the older BIOS does not come into play because 
SCSI has its own translation mechanism. 

This section provides information on both IDE and SCSI hard drive installations. The 
following are scenarios which outline, step-by-step, the installation procedures for a 
variety of system configurations.
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Scenario 1:
• The system has a BIOS that does not support drives over 504 MB in size.

• The source drive is an IDE drive that is smaller than 504 MB. It does not have a drive 
overlay program.

• The destination drive is an IDE drive that is larger than 504 MB and needs to have a 
drive overlay program in order to be recognized by the older BIOS.

Steps:

1. Install the destination drive as the Master and the source drive as the Slave and run the 
auto-detect in the BIOS.

2. Restart the computer with the drive overlay boot disk.

3. Install the drive overlay program to the destination drive that is now set as the Master 
(check with manufacturer).

4. Restart the computer again, allowing the drive overlay program to load.

5. Put your Drive Image bootable diskette in your diskette drive (A:).

6. In the drive overlay boot menu, select the option to boot from a floppy disk.

7. Make sure that Drive Image is showing the correct size for each drive and the correct 
order for the copy sequence.

8.  Finish the copy process.

Scenario 2:
• The system has a BIOS that does not support drives over 504 MB in size.

• The source drive is an IDE drive larger than 504 MB and a drive overlay program is 
loaded.

• The destination is a SCSI drive and will not need a drive overlay program.

Steps:

1. Leave the source drive set as the Master.

2. Install the SCSI drive with the lowest SCSI ID in the SCSI chain.
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3. Run the BIOS auto-detect and make sure it recognizes the IDE drive.

4. Run the SCSI BIOS to make sure the SCSI drive is recognized correctly.

5. Restart the computer and allow the drive overlay program to load. 

6. Put your Drive Image bootable diskette in your diskette drive (A:).

7. In the drive overlay boot menu, select the option to boot from a floppy disk.

8. Make sure that Drive Image is showing the correct size for each drive and the correct 
order for the copy sequence.

9. Finish the copy process.

Scenario 3:
• The system has a BIOS that does not support drives over 504 MB in size.

• The source drive is an IDE drive larger than 504 MB and a drive overlay program is 
installed.

• The BIOS is upgraded to a BIOS that supports larger drives.

• The destination drive is a SCSI drive that is larger than 504 MB.

Steps:

1. Leave the source drive set as the Master.

2. Install the destination drive and set it as drive 0.

3. Run the BIOS and auto-detect the drives.

4. Make sure that LBA is off for the source drive.

5. Run the SCSI BIOS to make sure the SCSI drive is recognized correctly.

6. Restart the computer and allow the drive overlay program to load. 

7. Put your Drive Image bootable diskette in your diskette drive (A:).

8. In the drive overlay boot menu, select the option to boot from a floppy disk.
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9. Make sure that Drive Image is showing the correct size for each drive and the correct 
order for the copy sequence.

10. Finish the copy process.

Scenario 4:
• The system has a BIOS that does not support drives over 504 MB in size.

• The source drive is an IDE drive larger than 504 MB and a drive overlay program is 
installed.

• The BIOS is upgraded to a BIOS that supports larger drives.

• The destination is an IDE drive that is larger than 504 MB.

Steps:

1. Set the source drive as the Master.

2. Set the destination drive as the Slave.

3. Run the new BIOS and auto-detect the drives.

4. Make sure that LBA is turned on for the destination drive and off for the source drive.

5. Restart the computer and allow the drive overlay program to load. 

6. Put your Drive Image bootable diskette in your diskette drive (A:).

7. In the drive overlay boot menu, select the option to boot from a floppy disk.

8. Make sure that Drive Image is showing the correct size for each drive and the correct 
order for the copy sequence.

9. Finish the copy process.
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Making the Operating System Assign 
a CD-ROM Drive Letter

If your computer has a CD-ROM drive or any form of removable media, you should be 
aware of potential problems with the way drive letters are assigned to these devices.

Drive Image does not make drive letter assignments; this is a function of the operating 
system. The operating system assigns drive letters in the following order: The first 
recognized primary partition on each hard drive will receive a letter, followed by all 
logical partitions on each hard drive. Next, the CD-ROM drive and any other form of 
removable media will be assigned a letter.

Because the CD-ROM is one of the last drives to receive a letter, any partitions that you 
create or delete on any of your hard drives will affect the drive letter assignment of your 
CD-ROM drive. This change in drive letter assignments is usually performed by the 
operating system automatically. Occasionally, however, the operating system will fail to 
assign a new drive letter to the CD-ROM drive. If this should occur, please follow the 
steps listed below.

If you are using DOS/Windows 3.11 or are loading your CD-ROM drivers under DOS 
with Windows 95, perform the following:

1. At a DOS prompt, type EDIT C:\CONFIG.SYS .

This starts the DOS editor program and opens your CONFIG.SYS file. 

2. Change LASTDRIVE= drive (in which drive is any letter of the alphabet) to Z.

This allows the OS to assign all drive letters through Z.

3. Click File>Exit .

4. Click Yes to save the file.

5. You should now be back to a C:\ prompt. Type EDIT C:\AUTOEXEC.BAT .

The DOS editor program starts and opens your AUTOEXEC.BAT file. 

6. Look for a line that includes the word MSCDEX. The /L:drive parameter (in which 
drive is the drive letter that was assigned to your CD-ROM before you made changes 
with Drive Image) may appear at the end of this line. Change this letter to U. 
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Because the OS assigns all other available drive letters before assigning Z, this 
ensures that partition changes you make in the future will not invalidate your 
CD-ROM drive letter. 

For more information, type HELP MSCDEX  at a DOS prompt.

NOTE: If your computer is on a network, when you log in to the network the letter Z 
and other letters at the end of the alphabet may be assigned to network 
search drives. In this case, assign your CD-ROM a letter just before the first 
letter used by the network search drives.

7. Select File, then Exit . When you are asked whether you want to save the file, click 
Yes.

8. When you see the DOS prompt (C:\), reboot your machine.

If you are using Windows 95 and Windows 95 drivers for the CD-ROM:

1. Click Start>Settings>Control Panel>System.

2. From the System Properties screen, select Device Manager.

This brings up a list of the devices in your computer. 

3. Double-click CDROM .

4. Click the Settings tab.

5. At the bottom of the Settings page is the heading, Reserved Drive Letters. Under 
this heading are two listings, Start Drive Letter and End Drive Letter . Change the 
values for these listings to U. 

Because the OS assigns all other available drive letters before assigning Z, this 
ensures that partition changes you make in the future will not invalidate your 
CD-ROM drive letter.

6. Click OK to close the Settings page. 

7. Click OK  to close the System Properties page.

8. Click Yes to restart your computer.
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Appendix

Troubleshooting

This appendix gives solutions to problems that you may encounter while using 
PowerQuest's Drive Image. Included are the following:

• Frequently Asked Questions

• Freeing Enough Conventional Memory to Run Drive Image

• Resolving Check Errors

• Resolving Partition Table Errors

• Partition Tables and Viruses

• Error Messages and Solutions

Frequently Asked Questions

PowerQuest maintains the latest Frequently Asked Questions on their Web site at 
http://www.powerquest.com/support/index.html.

Freeing Enough Conventional Memory to 
Run Drive Image

The DOS Drive Image executable running under DOS requires a minimum of 400KB of 
memory in the first 640KB of the computer's address space (conventional memory). If you 
try to run Drive Image from DOS and find you do not have enough free conventional 
memory, you can free enough additional memory in a number of ways.

B
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Running MEMMAKER

MEMMAKER is a program that automatically configures your computer to save 
conventional memory (while still loading all of the device drivers and other programs 
you usually load when booting DOS). MEMMAKER frees conventional memory by 
moving as many programs as possible out of conventional memory into high memory. 
Run MEMMAKER by typing MEMMAKER at a DOS prompt. Follow the on-screen 
instructions.

NOTE: MEMMAKER is only available with DOS versions prior to DOS 6.0. 
MEMMAKER is not available with Windows 95.

Using the F8 Key to Keep Programs From Loading

If running MEMMAKER does not free enough conventional memory, you can free more 
by pressing <F8> right after booting your computer (while DOS is booting). If you press 
<F8>, when DOS reads the commands from the CONFIG.SYS and AUTOEXEC.BAT 
files on your hard drive, DOS will ask you if you want it to execute each command. When 
you see commands that load device drivers or TSR programs that you will not need to run 
Drive Image, answer N (no) to tell DOS not to execute that command (not load that 
software into memory). This will conserve conventional memory. 

Using an Operating System Boot Diskette

If running MEMMAKER and using <F8> does not free enough conventional memory, 
you can create a boot diskette that allows you to boot using a very minimal amount of 
conventional memory.

You can create a boot diskette for any version of DOS by performing the following:

1. Place in your diskette drive (A:) any diskette that does not contain information you 
want to keep. 

2. Go to a DOS prompt, type FORMAT drive: /S (where drive is the drive letter of the 
diskette drive).

3. Press <ENTER>.
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After the diskette is formatted and the operating system files are transferred, you will be 
able to boot the computer from the diskette. If you restart your computer with the diskette 
in the diskette drive, your computer boots using a minimal amount of conventional 
memory. After you boot from the diskette, you can run Drive Image from either the 
diskette or your hard drive.

Creating a CONFIG.SYS File on the Boot Diskette

If making an ordinary boot diskette doesn't free enough conventional memory, you can 
create a customized boot diskette that will free even more conventional memory. (With 
the customized diskette, you will free more conventional memory by loading some of the 
DOS operating system into high memory.) To customize the diskette, you must create a 
CONFIG.SYS in the root directory (C:\). To create a CONFIG.SYS in the root directory, 
perform the following:

1. Go to a DOS prompt. 

2. Type drive: (where drive is the drive letter of the diskette drive) and press <ENTER>. 

Verify that you have changed to the diskette drive (you see the drive:\> prompt).

3. Type EDIT CONFIG.SYS and press <ENTER>. 

This starts the DOS editor (you will see a blank screen).

4. In the editor, type the following:

DEVICE=C:\DOS\HIMEM.SYS

DEVICE=EMM386.EXE

DOS=HIGH,UMB

NOTE: All lines must be entered in the order shown. Windows users: Substitute 
Windows for DOS.

5. Click File>Save to save the file. 

6. Click File>Exit to exit the editor.

You can now reboot your computer from the customized boot diskette. When DOS loads, 
much of it is loaded into high memory, saving a maximum amount of conventional memory.
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Deleting Operating System Compression Files

If you use DOS 6.22 and your system doesn't have any compressed drives (for example, 
DriveSpace, DoubleSpace, or Stacker), you can delete the operating system compression 
files DRVSPACE.BIN or DBLSPACE.BIN from any boot diskette you create. This frees 
more conventional memory because DOS 6.22 loads the contents of these files into 
memory, regardless of what's in the CONFIG.SYS or AUTOEXEC.BAT. These files are 
hidden system files, so if you wish to delete them you will have to perform the following:

1. From the DOS prompt, type drive: (where drive is the drive letter of the diskette 
drive).

2. Type ATTRIB -R -H -S *.BIN .

3. Type DEL *.BIN .

Resolving Check Errors

Drive Image checks the integrity of a partition very thoroughly prior to creating an image 
file or copying a partition. These checks are substantially the same as those made by the 
operating system's CHKDSK, SCANDISK, or AUTOCHK utility.

If you receive a Check error message for any partition, after backing up your hard drive, 
run your operating system's CHKDSK program on that partition. CHKDSK usually shows 
the same problem(s) as Drive Image.

NOTE: Run SCANDISK if you have MS-DOS 6.x or Windows 95. 

NOTE: The DOS CHKDSK program does not detect problems in Extended 
Attributes.

NOTE: If you are using Windows NT CHKDSK, DO NOT use the /F switch on the 
initial run. 

If CHKDSK (or SCANDISK) does not show the same error(s) that Drive Image shows, 
contact PowerQuest at the numbers listed in Appendix C.

If the CHKDSK (or SCANDISK) program and Drive Image detect the same errors (which 
is usually the case), run CHKDSK with the /F switch to fix the problem(s). 
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Resolving Partition Table Errors

NOTE: Run SCANDISK if you have DOS 6.x, or run CHKDSK if you have 
Windows NT.

After running CHKDSK with the /F switch, try running CHKDSK without using the /F 
switch to make sure the partition is free of errors. Under OS/2, you should perform this 
procedure twice before proceeding.

If Drive Image still reports a problem, reformat the partition and restore your files from 
the backup copy to correct the error.

Drive Image also checks a partition after restoring it. If this check fails, report the problem 
to PowerQuest at the numbers provided in Appendix C. While data loss is possible, in this 
case it is not typical. The problem is usually a minor file system error that CHKDSK /F 
can correct without data loss. For more extensive errors, you may need to restore your 
files from a backup copy.

Resolving Partition Table Errors

To resolve partition table errors, you must create new, error-free partition tables.

NOTE: In some cases, PowerQuest technical support can help you fix partition table 
errors without data loss. Check with them first before proceeding to the 
following steps.

To create new, partition tables, perform the following:

1. Make sure you have no viruses. 

NOTE: See “Partition Tables and Viruses” (page 106).

2. Back up the data on the affected partitions.

3. Delete the partitions.

NOTE: You may need to use the FDISK program from a recent DOS version because 
earlier versions of DOS may refuse to delete HPFS or hidden partitions.

NOTE: If using OS/2, the OS/2 FDISK program may recognize the partition's 
corruption and refuse to modify it. In this case, use the FDISK program from 
a recent DOS version.
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4. Recreate the partitions.

5. Restore the contents of the partitions. 

Partition Tables and Viruses

If partition changes made under one operating system are not reflected under the other, 
and vice versa, it is possible that a master boot record (MBR) virus is present.

Use a virus check utility that can detect the latest viruses. If a virus is found, data loss is 
likely. If a virus is found, perform the following:

1. Before removing the virus, run ScanDisk or CHKDSK under each of the operating 
systems to evaluate the integrity of the partition. 

2. Back up the files from any partition that passes the Check operation.

3. After backing up the files from all operating systems, remove the virus.

4. Run ScanDisk or CHKDSK under each of the operating systems again.

5. Delete and recreate any partitions that fail the check. 

6. Reinstall the operating system(s).

7. Restore the backup files as necessary.
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Error Messages and Solutions

NOTE: For a complete list of all our error messages and solutions, please visit our 
Knowledge Base at http://www.powerquest.com/support/kb.html.

Miscellaneous Errors (3–38)

#3   Not enough memory 

The DOS Drive Image executable running under DOS requires a minimum of 400KB of 
memory in the first 640KB of the computer's address space (conventional memory) and 
8MB of total memory. If you don't have enough conventional memory, see “Freeing 
Enough Conventional Memory to Run Drive Image” (page 101) for possible solutions.

#8   Could not allocate/deallocate DOS real mode memory 

The DOS Drive Image executable running under DOS requires some memory in the first 
1MB of the computer's address space (Drive Image uses a DOS extender). If not enough 
memory is available, Drive Image cannot access the hard drive. If you don't have enough 
conventional memory, see “Freeing Enough Conventional Memory to Run Drive Image” 
(page 101) for possible solutions.

#23   Unsupported version of operating system

The operating system versions that are required to run Drive Image are listed in “System 
Requirements” in the Introduction (page xix).

#34   This beta or evaluation version is no longer safe to use

PowerQuest occasionally releases beta versions and evaluation versions of Drive Image. 
Both versions are not as safe as released versions; therefore, PowerQuest builds an 
expiration date into each version. After a predetermined test period, the beta or evaluation 
version will no longer function. 

#36   DPMI Server error

Drive Image DOS executables use a DOS extender. This error indicates a failure during a 
call made from Drive Image through the DOS extender (to DOS or to the BIOS). The 
DOS extender may be in conflict with other programs that use extended memory. DOS 
would load the conflicting programs from your CONFIG.SYS or AUTOEXEC.BAT file 
during the normal boot sequence.
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You may be able to resolve this problem by pressing <F8> while booting DOS. After DOS 
boots and starts to read the commands from your CONFIG.SYS and AUTOEXEC.BAT 
files, DOS will ask if you want to execute each command. When you see commands that 
load device drivers or TSR programs that you think might be conflicting with the Drive 
Image DOS extender, answer N (no) to tell DOS not to execute that command (not to load 
that software into memory). You will often be able to find a program configuration that will 
enable Drive Image (the DOS extender) to run without error.

Disk Access Errors (40–56)

Errors in the 40-56 number range indicate that accessing your disk is not possible, and, 
often, are the result of hardware problems. Some problems may have simple solutions. For 
other problems, the only solution may be replacing the hard drive. When possible, Drive 
Image detects major errors before any changes have been made so you can back up your 
data before replacing the hard drive.

#49   Write fault 

#50   Read fault 

Drive Image is unable to write to/read from a specific sector on the hard drive. There are a 
number of possible causes of this error:

• If your PC beeps or displays a black box in the middle of the screen, virus protection is 
enabled in your computer's BIOS. Disable virus or boot sector protection in the BIOS.

• A virus protection application (which may be a TSR or DLL program) is in use. 
Disable the application before using Drive Image.

• There is a bad sector on the hard drive (this is usually the case with only older hard 
drives). Run SCANDISK on the hard drive to perform a surface scan to verify the 
existence of bad sectors. If your drive has bad sectors, we recommend you replace it.

• You have set up disk mirroring with PC-Tools. Disable the disk mirroring option.

• Your caching controller card is not set up properly.

Partition Table Errors (100–199)

Errors in the 100-199 number range are partition table errors. For general information 
about solving this type of error, see “Resolving Partition Table Errors” (page 105) and 
“Partition Tables and Viruses” (page 106).
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#100   Partition table is bad

The master boot record (MBR) can contain, at most, one extended partition, and each 
extended partition boot record (EPBR) can contain, at most, one link to another EPBR. 
This error occurs when a partition table violates the foregoing rule. Since any 
modifications Drive Image makes may decrease the amount of data that is recoverable 
from the hard drive, Drive Image will not recognize any of the hard drive's partitions. You 
must create new, error-free partition tables to resolve your problem. See “Resolving 
Partition Table Errors” (page 105).

#104   No sectors in partition

No partition should contain zero sectors. Delete the partition before using Drive Image. 

#105   Partition starts on wrong boundary

The hard-disk partition table contains erroneous values. Drive Image expects FAT, NTFS, 
and HPFS partitions to begin and end on the boundaries used by FDISK. If they do not, 
the disk may be partially corrupted. In this circumstance, if Drive Image were to make any 
modifications it might cause the loss of data. Therefore, Drive Image will refuse to 
recognize any of the hard drive's partitions. To resolve this problem, see “Resolving 
Partition Table Errors” (page 105).

#106   Partition doesn't start with sector one

See error #105.

#107   Partition begins after end of disk

This error can occur when you are running Drive Image on a hard drive that uses more 
than 1,024 cylinders. Under DOS, Drive Image is restricted by the BIOS 1,024 cylinder 
limit. If any partitions extend beyond the limit, Drive Image cannot safely operate on the 
hard drive.

This error can also occur if a partition erroneously extends beyond the physical end of the 
hard drive. This may happen if the hard drive has been used on a different computer or 
with a different hard-disk controller or if BIOS settings have been changed. Be advised 
that the physical geometry of the hard drive may differ from the logical geometry assigned 
to the hard drive by the operating system.

#108   Partition doesn't end at end of cylinder

See error #105.
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#109   Partition ends after end of disk

See error #107.

#110   Partition table number of sectors is inconsistent

The hard-disk partition table contains two inconsistent descriptions of the number of 
sectors on the hard drive. This error is serious if both DOS and another operating system 
use the hard drive. Because DOS uses one description and other operating systems may 
use the other, data loss is likely once the partition is almost full. To resolve this error, see 
“Resolving Partition Table Errors” (page 105).

#111   Logical partition starts outside Extended

The hard-disk partition table contains erroneous values. All logical partitions must be 
totally contained within the extended partition. To resolve this error, see “Resolving 
Partition Table Errors” (page 105).

#112   Logical partition ends outside Extended

See error #111. 

#113   Partitions overlap

The hard-disk partition table contains erroneous values. If data partitions overlap, writing 
to one may destroy data in another.

This error is sometimes the result of an OS/2 FDISK bug. If free space exists within the 
extended partition, OS/2's FDISK program allows a primary partition to be created that 
overlaps the extended partition. A logical partition is subsequently created in the space 
occupied by the overlapping primary partition. 

If a primary partition overlaps the end of the extended partition but does not overlap any 
logical partitions within the extended partition, the problem can be remedied by patching 
the partition table. Only qualified individuals should attempt this repair! An incorrect 
patch could destroy all data on the hard drive! In most instances, you should resolve the 
problem as explained in “Resolving Partition Table Errors” (page 105).

#116   Partition table Begin and Start inconsistent

The hard-disk partition table contains two inconsistent descriptions of the partition's 
starting sector. This error can occur if the operating system reports a hard-disk geometry 
that is different than the geometry in use when the partition table was written. Possible 
causes of the hard-disk geometry changing are: 
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• Different operating systems (for example, DOS and OS/2) report different hard-disk 
geometries.

• You boot from a diskette that loads a different driver than is loaded when you boot 
from the hard drive.

• Upgrading the operating system (for example, from OS/2 2.x to OS/2 Warp) causes a 
different driver to be used.

• The hard drive or controller has been changed.

• The BIOS has been upgraded.

• The BIOS LBA setting has been changed.

• There is a partition table virus present on the hard drive.

In most instances, you should resolve the problem as explained in “Resolving Partition 
Table Errors” (page 105). You can also use a virus scanning program to remove any 
partition table virus. Data loss is possible if the number of heads or sectors per track has 
changed since you first created your partitions.

#120   The logical drive chain is incompatible

This error occurs under some OSs when logical partitions are not chained together in the 
expected order. DOS, OS/2, Windows 95, and Windows NT require that logical partitions 
be chained together in ascending order. Some other operating systems do not require this. 
For example, some versions of the Linux FDISK utility chain logical partitions together in 
the order they are created. This error message identifies a very dangerous situation; using 
the DOS FDISK in this situation can cause loss of one or more partitions. 

For solutions to this problem, see the instructions in “Resolving Partition Table Errors” 
(page 105). 

If you decide to back up your data and recreate your partitions, you may have to use the 
same partitioning program that you used to create the partitions in order to delete them.

#121   The first sector of the drive cannot be read

The first sector of the hard drive (cylinder 0, head 0, sector 1) contains the master boot 
record (MBR) and the primary partition table. Drive Image cannot make changes to this 
hard drive because an error occurred when it read the first sector. See error #50 for 
information on resolving this error.
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#122   A bad sector was found in the current or new partition area

The partition cannot be moved safely because there is a bad sector in the new or current 
partition area. When you see this error message, the move operation will be aborted before 
any corruption can occur. Try moving the partition to a different place. If your hard drive 
has bad sectors, we recommend that you replace the hard drive.

Check Errors (500–599)

Check errors occur when Drive Image checks the integrity of a partition. For useful general 
information about resolving these errors, see “Resolving Check Errors” (page 104).

#500   Subdirectory is corrupted

This error message reveals the name of the corrupted subdirectory. Back up the contents 
of that directory and its subdirectories. You can then delete the corrupted subdirectory.

#501   Cross-linked files were found

ScanDisk or CHKDSK should be able to find these errors and correct them.

#506   Not enough free space on partition to shrink

Some free space (which is dependent on the hard drive's current contents) is required to 
resize a partition smaller. Delete unneeded and duplicate files in the partition and then 
attempt the operation again.

#508   As specified, the operation does not change the partition

You have entered a value that is the same as or (when rounded to the required cylinder 
boundary) rounds to the same as the partition's present value. Enter a larger change.

#509   A bad sector was detected in the current or new FS area

In order to perform the resize operation that you requested, Drive Image attempted to 
expand the file system area. However, the program found a bad sector in the new area. Try 
moving the partition before you resize it. No corruption will occur when you encounter 
this error.

#510   The version of the file system is not supported

An updated version of Drive Image is required to operate on this new version of the file 
system. Visit http://www.powerquest.com for information about updated versions of 
Drive Image.
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HPFS Check Errors (1000–1500)

Check errors occur when Drive Image checks the integrity of a partition. For useful 
general information about resolving these errors, see “Resolving Check Errors” 
(page 104).

#1015   System sector not marked unavailable

This error may indicate that there are open files on the hard drive. Shut down and restart 
OS/2, booting from diskettes. If this does not resolve the problem, run OS/2's CHKDSK 
program. This error message may also indicate that a file is listed with a file length of 
zero. OS/2's CHKDSK program will not fix this problem. As a last resort, delete the 
offending file.

#1027   Could not account for all sectors

This error may be resolved in one or more of the following ways:

• If you are working with an HPFS386 partition, check the technical support area of 
PowerQuest's Web site for more information.

• If CHKDSK has created any FOUND.000 or *.CHK files, delete them.

• If the error message indicates the name of the offending file, delete it.

• Turn off the disk-mirroring option in PC-Tools.

• If none of the above solutions works, back up the partition, delete it, recreate it, and 
restore the data.

#1045   Stac volume detected delete—Stac volume before converting

This error message occurs when you attempt to convert a partition to HPFS, and the existing 
partition contains a STAC volume. Stacker cannot access a STAC volume that is on an 
HPFS partition. Delete the STAC volume from the partition before converting to HPFS.

NTFS Check Errors (1500–1699)

Errors 1500-1699 are NTFS-specific error messages. In this context, “attribute” does not 
mean read-only, hidden, system, and so on. Rather, “attribute” means one of a file’s data 
streams. Check errors occur when Drive Image checks the integrity of a partition. For 
useful general information about resolving these errors, see “Resolving Check Errors” 
(page 104).
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#1501   Wrong version of NTFS

The partition was created using a version of the NTFS file format that Drive Image cannot 
work with.

#1503   Bad NTFS cluster size

The NTFS cluster size must be 512, 1,024, 2,048, or 4,096 bytes.

#1512   Restart record mismatch

The two restart entries in the journal file are different. This may happen if Windows NT is 
not properly shut down. To fix this problem, restart Windows NT and shut it down using 
the Shut Down command.

#1516   Partition improperly dismounted

The partition dirty flag is set in a restart record in the journal file. This error may have been 
caused by a power failure or system crash while the Windows NT operating system was 
writing the partition. Reboot Windows NT and execute CHKDSK /F to repair the damage.

#1527   Bad update sequence number

A buffer contains mismatched update sequence numbers. This error may have been caused 
by a power failure or system crash while the Windows NT operating system was writing 
to the partition. Reboot Windows NT and execute CHKDSK /F to repair the damage.

#1529   Information mismatch in directory entry

A file attribute stored in a file record is different from the attribute stored in its directory 
entry. If this error is in a system file (file 0-10), Windows NT's CHKDSK program will 
not fix it, but Windows NT will rebuild the root directory on the partition the next time the 
operating system is started.

#1538   Can't find contiguous space to move

The partition does not contain enough contiguous free space to hold the new copy of a file 
that must be contiguous. You will normally encounter this error when you use the Resize 
option to resize a partition smaller.

#1539   File size mismatch

The size of a system file (file 0-10) recorded in its file record does not match either the 
size recorded in its directory entry in the root directory or the size of its data stream.
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#1544   External attribute list in external attribute

An external file record has an external attribute list.

#1545   File attributes out of order

The attributes in a file must appear in order of increasing numeric type.

#1546   Attribute neither resident nor nonresident

The attribute resident flag has a value other than resident or nonresident.

#1547   Wrong run limits

A run has more clusters than the difference between its highest and lowest cluster.

#1548   File table has fewer than 16 entries

The file table must have at least 16 entries.

#1549   File table has more than 4 billion entries

The file table must have fewer than 4 billion entries.

#1644   Bad system file sequence number

A system file has a bad sequence number. System files must have a sequence number from 
0 to 10. A partition with this problem may pass a run of Windows NT's CHKDSK 
program, but Windows NT will not mount the partition the next time the operating system 
is started.

#1647   Error in root directory index

There is an error in the root directory's index. Running Windows NT's CHKDSK program 
will not fix this problem, but the Windows NT operating system will automatically rebuild 
the root directory on the partition the next time it is started.

Miscellaneous Drive Image Error Messages

#1701   Err disk not empty 

Used in scripting. The DELETE ALL command failed to delete all the partitions on the drive.

#1800   Err partition not open

Attempted operation on a partition in an improperly opened image file.
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#1801   Err partition not found

Did not find requested partition in image file.

#1802   Err corrupt bundle

Image file header information is not valid.

#1803   Err bundle read only

Attempted to delete or write to a partition in the image file which was opened in Read 
Only mode.

#1804   Err no bitmap Image

File contains no partition bitmap.

#1805   Err write failed 

Error encountered while writing image to file. This error usually occurs when Drive Image 
runs out of space in the partition to which it is writing an image file.

#1806   Err out of memory

Out of Memory.

#1807   Err compression

Error encountered while compressing or decompressing image file data.

#1808   Err buffer too small

Buffer too small to read in partition bitmap.

#1809   Err no more free space

No more free space available to process remaining partitions.

#1810   Err open failed

Could not open image file.

#1811   Err read failed

Could not read from image file.
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#1900   Err invalid drive number

Used in scripting. The script contains an invalid drive number.

FAT Check Errors (2000–2099)

Check errors occur when Drive Image checks the integrity of a partition. For useful 
general information about resolving these errors, see “Resolving Check Errors” 
(page 104).

#2001   FAT copies are not identical

Run SCANDISK to fix this error. This problem may also be caused by a virus. Run a virus 
checker and remove the virus if possible.

#2005   One or more lost clusters were found

Run SCANDISK or CHKDSK to fix this error. 

#2012   Formatted FAT file system too big for partition

This error can be caused by the following circumstances:

• The number of sectors in the partition is larger than 65,536, and the bsHugeSects field 
of the boot sector (“Big total number of sectors” in Norton's DISKEDIT utility) shows 
that there are more sectors in the partition than the partition table shows.

• The number of sectors in the partition is less than 65,536, and the bsSects field of the 
boot sector (“Total sectors on disk” in Norton's DISKEDIT utility) shows that there are 
more sectors in the partition than the partition table shows.

This situation can result in data loss when the FAT file system tries to use space outside 
the partition that does not exist or that belongs to another partition. Since file data may 
exist outside the partition boundary, you cannot fix the problem by simply patching the 
boot sector.

To correct the error, back up all data on the partition, delete the partition, recreate the 
partition, and restore the data. Alternately, it has been reported that you can use Norton 
Disk Doctor to fix this problem.
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#2013   A component of FAT geometry is bad

This error can be caused by the following circumstances:

• The number of clusters on the hard drive is greater than the FAT limits allow. This can 
result from bad values in the boot sector for the number of sectors, FATs, root entries, 
reserved sectors, and sectors per cluster.

• The number of sectors in the FAT is not large enough to hold the number of clusters 
present on the hard drive.

A qualified consultant may be able to fix the hard drive by performing simple patches. 
Alternately, you can back up the data on the partition, delete the partition, recreate the 
partition, and restore the files.

#2024   The OS/2 Extended Attribute file is corrupt

This error is caused by any program that mistakenly writes to or overwrites the OS/2 
Extended Attribute file. If this error occurs, you should back up your data, delete the 
partition, recreate the partition, and restore your data. 
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PowerQuest Technical Support

Contact Information

This appendix contains the following information:

• Before you Contact Technical Support

• PowerQuest Problem Report

• Contacting PowerQuest Technical Support

Before You Contact Technical Support

PowerQuest is committed to providing you with comprehensive technical support. 
However, before calling our technical support department, try to resolve your problem by 
using this guide, the online Help system, or check PowerQuest's Web site for Frequently 
Asked Questions at http://www.powerquest.com/support/index.html, or for international 
customers, see http://www.powerquest.com/intnl/index.html. Also, check the 
README.TXT file for information that has changed since this guide was printed.

C
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PowerQuest Problem Report

If you cannot find the solutions you need in this guide, please have the following 
information ready or send it along when you contact technical support:

Your Company Name ___________________________________________________________________________________

Your Name ___________________________________________________________________________________________

Your Voice Phone Number ______________________________________________________________________________

Your Fax Phone Number ________________________________________________________________________________

Drive Image Serial Number ______________________________________________________________________________

Computer Manufacturer ________________________________________________________________________________

Computer Model and Model Number _____________________________________________________________________

Date of Computer Manufacture __________________________________________________________________________

Processor Type _______________________________________________________________________ (386, 486, Pentium)

Amount of Memory (RAM) ______________________________________________________________________________

KB Operating System / Version Number _____________________________________________________ (DOS 6.21, etc.)

Other Hardware. Include bus type (ISA, EISA, MCA, PCI, VESA), hard drive model, and external drives.

______________________________________________________________________________________________________

______________________________________________________________________________________________________

______________________________________________________________________________________________________

Memory Resident Software. Include memory managers and list their version numbers (for example, OnTrack’s Disk 
Manager Version 6.0 or EZ-Drive Version 7.0).

______________________________________________________________________________________________________

______________________________________________________________________________________________________

______________________________________________________________________________________________________
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Contacting PowerQuest Technical Support
If you cannot get the help you need from this guide, you can contact our technical support 
department in any of the ways listed below. You must be a registered Drive Image user to 
receive the following types of technical support. PowerQuest offers free support for three 
months following your first call to PowerQuest’s technical support.

Fax

USA (801) 434-3060

Europe (+31) 20 582 9260

Fax the information listed on the pages above and a description of your problems to the 
technical support fax number. This service is available in the U.S., and Canada, and 
Europe 24 hours a day, 7 days a week. We try to respond to all fax requests within 24 
hours.

FaxBack

USA Toll Free (800) 720-0391

USA (801) 437-7921

BBS 

USA (801) 226-5608 

Call the PowerQuest bulletin board for product information and answers to frequently 
asked technical questions. The correct modem setup is N-8-1. Our BBS supports 
transmission speeds from 1200bps to 28.8Kbps.

Telephone

USA (801) 226-6834 

Support is available Monday through Friday, 8 a.m. to 5 p.m. MST/MDT.

Internet 

You can contact PowerQuest through the Internet by sending an E-mail message to:

support@powerquest.com.

Corporate Web Site 

http://www.powerquest.com.
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Postal Service Mail 

USA Europe

PowerQuest Corp. PowerQuest
P.O. Box 1911 Orlyplein 85
Orem, Utah  84059-1911  U.S.A. 1043 DS

Amsterdam

Netherlands

Contacting PowerQuest International Technical Support

Internet

Telephone

Our European call centre is open from 9:00 to 18:00 CET and is available in the 
following languages:

Language Email Address

Dutch eurots@powerquest.com

French eurots@powerquest.com

English eurots@powerquest.com

German eurots@powerquest.com

Spanish latina@powerquest.com

Language Location Number

Dutch Netherlands (+31) 20 5813906

French France (+33) 1 69 32 49 30

German Germany (+49) 069 66 568 516

English UK (+44) 0171 341 55 17

English Netherlands (+31) 20 5813907
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ATA

A standard used by hard drives to communicate with the controller ports or cards that 
allow the hard drive to interface with the computer. Before ATA, there were numerous 
incompatible methods for interfacing hard drives to computers. ATA simplifies this 
process, thus reducing the cost of developing and purchasing related hardware. ATA is the 
proper term for Integrated Drive Electronics (IDE).

ATA-2

ATA-2 is the common name for a new, enhanced IDE standard. This standard is still 
evolving and has not yet been submitted for approval as an official standard.

Batch Mode

Switches in a normally interactive program that prepare it to receive non-interactive 
command input.

BIOS (Basic Input/Output System)

The BIOS is the program code stored in a PC-compatible ROM to boot the computer and 
provide basic services such as low-level hard drive access.

Cloning 

Copying a hard drive to an image file or destination disk to create an exact duplicate.

Destination

The destination hard drive is the drive that is copied to during a copy operation.

Disk

A hardware device to store data. A disk contains a Master Boot Record and partitions.

EIDE (Enhanced Integrated Drive Electronics)

A marketing program that promotes certain features of ATA-2.
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Extended Partition

One of the four primary partitions on a hard drive can be an extended partition. Extended 
partitions do not directly hold data; rather, you can create an unlimited number of logical 
partitions within the extended partition to store data. An extended partition cannot be the 
active partition.

FAT File Allocation Table

File system used by DOS, Windows 95, NT and sometimes OS/2 to store and retrieve files 
and directories.

FAT32

FAT32 is the file system used by updated versions of Windows 95 (version 4.00.950B or 
above). FAT32 is an enhancement of the FAT file system and is based on 32-bit file 
allocation table entries, rather than on the 16-bit entries the FAT file system uses. As a 
result, FAT32 supports much larger volumes (up to 2 terabytes).

GB (Gigabyte)

1,073,741,824 bytes.

IDE

See ATA.

Image

An image is a snapshot of a drive’s partition(s) that can be used to backup a system, install 
a new hard drive, or configure a new system.

Jumper 

Metal prongs and a circuit completion cap on the outside of a hard drive. You can 
remove, reposition, and then replace the cap to create various jumper settings such as 
Master and Slave.

HPFS

High Performance File System an alternative to a FAT file system which is used by OS/2.

Interactive Mode

An operation mode where the program's responses alternate with user commands, each 
being dependent upon the other.
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LBA (Logical Block Addressing)

1) In EIDE, a means of specifying sector addresses by replacing CHS values with a single 
linear 28-bit number. 2) Generically, a one-dimensional address of a hard-disk sector, 
contrast with CHS.

Linux

Linux Ext2 file system was developed for the Linux operating system (a free-ware version 
of the UNIX operating system). Linux Ext2 file system supports a maximum volume size 
of 4 terabytes.

Logical Drive

A contiguous area inside an extended partition that can be used by the operating system to 
store and retrieve files.

Master 

The first hard drive on an IDE hard drive controller.

MB (Megabyte)

1,048,576 bytes.

NetBIOS

A high level Network programming interface which is supported by lower level Network 
protocols such as IP/SP and TCP/IP.

NetWare

The Novell NetWare network operating system uses the NetWare File System, which was 
developed specifically for use by NetWare servers.

NTFS New Technology File System. 

An alternative to FAT and HPFS file systems used by WinNT.

Partition

An uninterrupted area on a disk, defined in the Master Boot Record. Every partition 
contains a specific file system such as FAT, FAT32, HPFS or NTFS.
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Primary Partition

A partition referenced in the Master Boot Record partition table. Four primary partitions 
can exist on a hard drive. One of these may be an extended partition. Only one primary 
partition on a drive may be active at time. Data and applications are often placed on a 
logical partition inside an extended partition. This enables the data to be accessed by all 
primary partitions.

Restore

Downloading an image file to a destination drive. The Restore and Download script 
arguments are interchangeable and accomplish the same function.

Slave

The second hard drive on an IDE hard drive controller.

Script File

A series of instructions, usually in text file format, written to be passed to a program 
running in batch mode. 

Source

The Source hard drive is the drive from which the copy is made.

Volume

This User Guide uses the term volume interchangeably with partition.
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